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This document applies to the following vector network analyzer models and their options:
® R&S®ZNB4, 9 kHz to 4.5 GHz, 2 test ports, order no. 1311.6010K22

® R&S®ZNB4, 9 kHz to 4.5 GHz, 2 test ports, order no. 1334.3330K22

® R&S®ZNB4, 9 kHz to 4.5 GHz, 4 test ports, order no. 1311.6010K24

® R&S®ZNB4, 9 kHz to 4.5 GHz, 4 test ports, order no. 1334.3330K24

® R&S®ZNB8, 9 kHz to 8.5 GHz, 2 test ports, order no. 1311.6010K42

® R&S®ZNBS8, 9 kHz to 8.5 GHz, 2 test ports, order no. 1334.3330K42

® R&S®ZNB8, 9 kHz to 8.5 GHz, 4 test ports, order no. 1311.6010K44

® R&S®ZNBS, 9 kHz to 8.5 GHz, 4 test ports, order no. 1334.3330K44

® R&S®ZNB20, 100 kHz to 20 GHz, 2 test ports, order no. 1311.6010K62

® R&S®ZNB20, 100 kHz to 20 GHz, 2 test ports, order no. 1334.3330K62

® R&S®ZNB20, 100 kHz to 20 GHz, 4 test ports, order no. 1311.6010K64

® R&S®ZNB20, 100 kHz to 20 GHz, 4 test ports, order no. 1334.3330K64

® R&S®ZNB26, 100 kHz to 26.5 GHz, 2 test ports, order no. 1334.3330K63

® R&S®ZNB26, 100 kHz to 26.5 GHz, 4 test ports, order no. 1334.3330K65

® R&S®ZNB40, 10 MHz to 40 GHz, 2 test ports, order no. 1311.6010K72

® R&S®ZNB40, 100 kHz to 40 GHz, 2 test ports, order no. 1311.6010K82

® R&S®ZNB40, 100 kHz to 40 GHz, 4 test ports, order no. 1311.6010K84

® R&S®ZNB43, 100 kHz to 43.5 GHz, 2 test ports 2.92 mm, order no. 1334.3330K92
® R&S®ZNB43, 100 kHz to 43.5 GHz, 2 test ports 2.4 mm, order no. 1334.3330K93
® R&S®ZNB43, 100 kHz to 43.5 GHz, 4 test ports 2.92 mm, order no. 1334.3330K94
® R&S®ZNB43, 100 kHz to 43.5 GHz, 4 test ports 2.4 mm, order no. 1334.3330K95

® R&S®ZNBTS, 9 kHz to 8.5 GHz, 4 test ports (up to 24 ports optional),
order no. 1318.7006K24

® R&S®ZNBT20, 100 kHz to 20 GHz, 8 test ports (up to 24 ports optional),
order no. 1332.9002K24

® R&S®ZNBT20, 100 kHz to 20 GHz, 8 test ports (up to 24 ports optional),
order no. 1332.9002K64

® R&S®ZNBT26, 100 kHz to 26.5 GHz, 8 test ports (up to 24 ports optional),
order no. 1332.9002K34

® R&S®ZNBT40, 100 kHz to 40 GHz, 8 test ports (up to 24 ports optional),
order no. 1332.9002K44
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R&S®ZNB/ZNBT Safety and regulatory information

1.1

Safety instructions

Safety and regulatory information

The product documentation helps you use the product safely and efficiently. Follow the
instructions provided here and in the following chapters.

Intended use

The product is intended for the development, production and verification of electronic
components and devices in industrial, administrative, and laboratory environments.
Use the product only for its designated purpose. Observe the operating conditions and
performance limits stated in the data sheet.

Target audience

The target audience of this document includes developers and technicians, administra-
tors and maintenance personnel performing RF signal measurements. The required
skills and experience of the users depend on the test setup and application of the prod-
uct.

Where do | find safety information?

Safety information is part of the product documentation. It warns you of potential dan-
gers and gives instructions on how to prevent personal injury or damage caused by
dangerous situations. Safety information is provided as follows:

® |n Chapter 1.1, "Safety instructions”, on page 7. A printed version of the relevant
information is provided in many languages in printed format.

"Safety Instructions" for "Mains-Powered Products, Not Heavy" (document
number 1171.1771.99) is delivered with R&S ZNB.

"Safety Instructions" for "Mains-Powered Products, Heavy" (document number
1171.1788.99) is delivered with R&S ZNBT.

(Note that the safety information on heavy instruments is particularly important for
R&S ZNBT.)

® Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.

Safety instructions

Products from the Rohde & Schwarz group of companies are manufactured according
to the highest technical standards. To use the products safely, follow the instructions
provided here and in the product documentation. Keep the product documentation
nearby and offer it to other users.

Use the product only for its intended use and within its performance limits. Intended
use and limits are described in the product documentation such as the specifications
document, manuals and the printed "Safety Instructions" document. If you are unsure
about the appropriate use, contact Rohde & Schwarz customer support.

Getting Started 1316.0062.02 — 66 7
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Safety instructions

Using the product requires specialists or specially trained personnel. These users also
need sound knowledge of at least one of the languages in which the user interfaces
and the product documentation are available.

Reconfigure or adjust the product only as described in the product documentation or
the specifications document. Any other modifications can affect safety and are not per-
mitted.

Never open the casing of the product. Only service personnel authorized by

Rohde & Schwarz are allowed to repair the product. If any part of the product is dam-
aged or broken, stop using the product. Contact Rohde & Schwarz customer support at
https://www.rohde-schwarz.com/support.

Lifting and carrying the product

The product is heavy. Do not move or carry the product by yourself. A single person
can only carry a maximum of 18 kg safely depending on age, gender and physical con-
dition. Look up the maximum weight in the specifications document. Use the product
handles to move or carry the product. Do not lift by the accessories mounted on the
product. Accessories are not designed to carry the weight of the product.

To move the product safely, you can use lifting or transporting equipment such as lift
trucks and forklifts. Follow the instructions provided by the equipment manufacturer.

Choosing the operating site

Only use the product indoors. The product casing is not waterproof. Water that enters
can electrically connect the casing with live parts, which can lead to electric shock,
serious personal injury or death if you touch the casing.

If Rohde & Schwarz provides accessories designed for outdoor use of your product,
e.g. a protective cover, you can use the product outdoors.

You can operate the product up to an altitude of 2000 m above sea level. If a higher
altitude is permissible, the value is provided in the specifications document. The prod-
uct is suitable for pollution degree 2 environments where nonconductive contamination
can occur. For more information on environmental conditions such as ambient temper-
ature and humidity, see the specifications document.

Setting up the product

Always place the product on a stable, flat and level surface with the bottom of the prod-
uct facing down. If the product is designed for different positions, secure the product so
that it cannot fall over.

If the product has foldable feet, always fold the feet completely in or out to ensure sta-
bility. The feet can collapse if they are not folded out completely or if the product is
moved without lifting it. The foldable feet are designed to carry the weight of the prod-
uct, but not an extra load.

If stacking is possible, keep in mind that a stack of products can fall over and cause
injury.

If you mount products in a rack, ensure that the rack has sufficient load capacity and
stability. Observe the specifications of the rack manufacturer. Always install the prod-
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Safety instructions

ucts from the bottom shelf to the top shelf so that the rack stands securely. Secure the
product so that it cannot fall off the rack.

Connecting the product

Before connecting the interfaces and measuring inputs of the product to other products
or electrical circuits, make sure that the other products or electrical circuits provide
special protection against electric shock. This protection principle is referred to as
SELV (safety extra-low voltage) and is based on a low voltage level and increased
insulation. Exceptions are indicated by a measurement category on the product and
given in the specifications document.

Connecting to power

The product is an overvoltage category Il product. Connect the product to a fixed
installation used to supply energy-consuming equipment such as household applian-
ces and similar loads. Keep in mind that electrically powered products have risks, such
as electric shock, fire, personal injury or even death. Replace parts that are relevant to
safety only by original parts, e.g. power cables or fuses.

Take the following measures for your safety:

® Before switching on the product, ensure that the voltage and frequency indicated
on the product match the available power source. If the power adapter does not
adjust automatically, set the correct value and check the rating of the fuse.

e |f a product has an exchangeable fuse, its type and characteristics are indicated
next to the fuse holder. Before changing the fuse, switch off the product and dis-
connect it from the power source. How to change the fuse is described in the prod-
uct documentation.

® Only use the power cable delivered with the product. It complies with country-spe-
cific safety requirements. Only insert the plug into an outlet with protective conduc-
tor terminal.

® Only use intact cables and route them carefully so that they cannot be damaged.
Check the power cables regularly to ensure that they are undamaged. Also ensure
that nobody can trip over loose cables.

® Only connect the product to a power source with a fuse protection of maximum
20 A

® Ensure that you can disconnect the product from the power source at any time.
Pull the power plug to disconnect the product. The power plug must be easily
accessible. If the product is integrated into a system that does not meet these
requirements, provide an easily accessible circuit breaker at the system level.

Cleaning the product

Use a dry, lint-free cloth to clean the product. When cleaning, keep in mind that the

casing is not waterproof. Do not use liquid cleaning agents.

Meaning of safety labels

Safety labels on the product warn against potential hazards.

Getting Started 1316.0062.02 — 66 9



R&S®ZNB/ZNBT Safety and regulatory information

Korea certification class A

Potential hazard

Read the product documentation to avoid personal injury or product damage.

Heavy product

Be careful when lifting, moving or carrying the product. Carrying the product requires a suffi-
cient number of persons or transport equipment.

Electrical hazard

Indicates live parts. Risk of electric shock, fire, personal injury or even death.

Hot surface

Do not touch. Risk of skin burns. Risk of fire.

Protective conductor terminal

Connect this terminal to a grounded external conductor or to protective ground. This connec-
tion protects you against electric shock if an electric problem occurs.

® B PP

1.2 Warning messages in the documentation

A warning message points out a risk or danger that you need to be aware of. The sig-
nal word indicates the severity of the safety hazard and how likely it will occur if you do
not follow the safety precautions.

WARNING

Potentially hazardous situation. Could result in death or serious injury if not avoided.

NOTICE

Potential risks of damage. Could result in damage to the supported product or to other
property.

1.3 Korea certification class A

o] 7171 QT8 2 =
uhebs, 714 9] o] A ol A ALgah AL BA oz g
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Service manual

2 Documentation overview

This section provides an overview of the R&S ZNB/ZNBT user documentation. Unless
specified otherwise, you find the documents at:

® https://www.rohde-schwarz.com/manual/ZNB

® https://www.rohde-schwarz.com/manual/ZNBT

2.1 Getting started manual

Introduces the R&S ZNB/ZNBT and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc.

A printed version is delivered with the instrument. A PDF version is available for down-
load on the Internet.

2.2 User manual and help

The user manual contains the description of all instrument modes and functions. It also
provides an introduction to remote control, a complete description of the remote control
commands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

The contents of the user manual are available as help in the R&S ZNB/ZNBT. The help
offers quick, context-sensitive access to the complete information for the instrument
and its firmware.

The user manual is also available for download or for immediate display on the Inter-
net.

2.3 Service manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

® R&S ZNB Service Manual
® R&S ZNBT Service Manual

Getting Started 1316.0062.02 — 66 1"
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2.5

2.6

2.7

Release notes and open source acknowledgment (OSA)

Instrument security procedures

Deals with security issues when working with the R&S ZNB/ZNBT in secure areas. It is
available for download on the internet.

Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

Specifications document and brochure

The specifications document, also known as the data sheet, contains the technical
specifications of the R&S ZNB/ZNBT. It also lists the firmware applications and their
order numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See

® https://www.rohde-schwarz.com/brochure-datasheet/ZNB

® https://www.rohde-schwarz.com/brochure-datasheet/ZNBT

Release notes and open source acknowledgment
(OSA)

The release notes list new features, improvements and known issues of the current
software version, and describe the software installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

See

® https://www.rohde-schwarz.com/firmware/ZNB

® https://www.rohde-schwarz.com/firmware/ZNBT

An HTML version of the OSA is installed with the analyzer firmware. It can be opened

from the main menu of the VNA's graphical user interface ("Help">"About">"Open
Source Acknowledgment: Open...").
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Application notes, application cards, white papers, etc.

2.8 Application notes, application cards, white papers,
etc.

These documents deal with special applications or background information on particu-
lar topics.

See
® https://www.rohde-schwarz.com/application/ZNB
® https://www.rohde-schwarz.com/application/ZNBT
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3

3.1

3.2

3.3

Choosing the operating site

Preparing for use

Here, you can find basic information about setting up the product for the first time.

Lifting and carrying
The carrying handles are designed to lift or carry the instrument. Do not apply exces-
sive external force to the handles.

See "Lifting and carrying the product" on page 8.

Unpacking and checking

1. Unpack the R&S ZNB/ZNBT carefully.

2. Retain the original packing material. Use it when transporting or shipping the
R&S ZNB/ZNBT later.

3. Using the delivery notes, check the equipment for completeness.
4. Check the equipment for damage.

If the delivery is incomplete or equipment is damaged, contact Rohde & Schwarz.

Choosing the operating site

Specific operating conditions ensure proper operation and avoid damage to the prod-
uct and connected devices. For information on environmental conditions such as ambi-
ent temperature and humidity, see the specifications document.

For safety information, see "Choosing the operating site" on page 8.

Electromagnetic compatibility classes
The electromagnetic compatibility (EMC) class indicates where you can operate the
product. The EMC class of the product is given in the specifications document.
® C(Class B equipment is suitable for use in:
— Residential environments

— Environments that are directly connected to a low-voltage supply network that
supplies residential buildings

® C(Class A equipment is intended for use in industrial environments. It can cause
radio disturbances in residential environments due to possible conducted and radi-
ated disturbances. It is therefore not suitable for class B environments.
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Setting up the product

If class A equipment causes radio disturbances, take appropriate measures to
eliminate them.

3.4 Setting up the product

See also:
® "Setting up the product” on page 8
® ‘"Intended use" on page 7

3.4.1 Placing the product on a bench top

To place the product on a bench top

1. Place the product on a stable, flat and level surface. Ensure that the surface can
support the weight of the product. For information on the weight, see the specifica-
tions document.

2. WARNING! A stack of products can fall over and cause injury. Never stack more
than two products. Otherwise, mount them in a rack.

Stack as follows:

e All products must have the same dimensions (width and length).
e Do not exceed a total load of 50 kg placed on the product at the bottom of the
stack.

Left = Stacked correctly
Right = Stacked incorrectly, too many products

3. NOTICE! Overheating can damage the product.
Prevent overheating as follows:

e Keep a minimum distance of 10 cm between the fan openings of the product
and any object in the vicinity to provide sufficient airflow and ventilation.
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3.4.2

3.5

Considerations for test setup

e Do not place the product next to heat-generating equipment such as radiators
or other products.

Mounting the product in a rack

To prepare the rack
1. Observe the requirements and instructions in "Setting up the product" on page 8.

2. NOTICE! Insufficient airflow can cause overheating and damage the product.
Design and implement an efficient ventilation concept for the rack.

To mount the R&S ZNB/ZNBT in a rack

1. Use an adapter kit to prepare the R&S ZNB/ZNBT for rack mounting.

a) Order the rack adapter kit R&S ZZA-KN5 (order number 1175.3040.00).
b) Mount the adapter kit. Follow the assembly instructions provided with the
adapter Kkit.

2. Lift the R&S ZNB/ZNBT to shelf height.

3. Grab the handles and push the R&S ZNB/ZNBT onto the shelf until the rack brack-
ets fit closely to the rack.

4. Tighten all screws in the rack brackets with a tightening torque of 1.2 Nm to secure
the R&S ZNB/ZNBT in the rack.

To unmount the R&S ZNB/ZNBT from a rack

1. Loosen the screws at the rack brackets.

2. Remove the R&S ZNB/ZNBT from the rack.

3. If placing the R&S ZNB/ZNBT on a bench top again, unmount the adapter kit from
the R&S ZNB/ZNBT. Follow the instructions provided with the adapter kit.

Considerations for test setup

Cable selection and electromagnetic interference (EMI)
Electromagnetic interference (EMI) can affect the measurement results.

To suppress electromagnetic radiation during operation:

® Use high-quality shielded cables, for example, double-shielded RF and LAN
cables.

® Always terminate open cable ends.
® Ensure that connected external devices comply with EMC regulations.
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Regarding length and quality, the following requirements have to be met for cables that

are directly connected to the R&S ZNB/ZNBT:

Table 3-1: Cable Requirements

Cable Type (Connector)

Requirement

RF cables (PORT 1, ..., PORT N)

Double shielded

BNC cables (various)

Double shielded

DB-25 (User Port)

Double shielded

Digital I/Q (DIRECT CTRL, AUX CONTROL)

R&S order no. 1402.4990.00 only

GPIB Standard cable
Handler I/O Standard cable
RFFE/GPIO R&S ZN-Z25 (order no. 1334.3424.02) only

DisplayPort (Monitor)

Standard cable

DVI-D (Monitor)

2 ferrite cores

LAN At least CAT6, S/IFTP
PCle Standard cable
USB Standard cables, length < 3m

Signal input and output levels

Information on signal levels is provided in the specifications document. Keep the signal
levels within the specified ranges to avoid damage to the product and connected devi-
ces.

Preventing electrostatic discharge (ESD)
Electrostatic discharge is most likely to occur when you connect or disconnect a DUT.

» NOTICE! Electrostatic discharge can damage the electronic components of the
product and the device under test (DUT).

Ground yourself to prevent electrostatic discharge damage:

a) Use a wrist strap and cord to connect yourself to ground.
b) Use a conductive floor mat and heel strap combination.

During operation, if the firmware observes a serious unexpected disturbance (e.g. due
to ESD), it resets all hardware components to ensure proper instrument functioning. It

then restores the user settings to the state before the disturbance and indicates the
foregone hardware reset by an "Hardware communication problem [...]" information

popup.

3.6 Connecting the analyzer to the AC supply

For safety information, see "Connecting to power" on page 9.
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3.7

Switching the instrument on and off

The network analyzer is automatically adapted to the AC supply voltage, which must
be in the range of 100 V to 240 V at 50 Hz to 60 Hz. A line frequency of 400 Hz is also
supported.

The AC power connector is located in the upper part of the rear panel (see Chap-
ter 4.3, "Rear panel R&S ZNB", on page 38 or Chapter 4.4, "Rear panel R&S ZNBT",
on page 41).

1. Plug the AC power cable into the AC power connector on the rear panel of the
product. Only use the AC power cable delivered with the product.

2. Plug the AC power cable into a power outlet with ground contact.

The required ratings are listed next to the AC power connector and in the data
sheet.

3. If necessary, also ground the product using the grounding terminal <.

The maximum power consumption and the typical power consumption of the individual
analyzer models are listed in the data sheet.

The R&S ZNBT is protected by a fuse located below the AC power switch. For fuse
replacement, see the corresponding section in the maintenance chapter of the user
manual. There is no such fuse on the R&S ZNB.

Risk of data loss due to voltage dips

For a R&S ZNBT40 with 24 ports, a 0% voltage dip with a duration of 18 ms or longer
can cause a reboot of the instrument. In this case the reboot time is approximately
90 s.

Note that after the reboot, the instrument loads the settings that were active before the
most recent regular shutdown. To save your configuration changes and get them
restored after an EMC event, you have to perform a regular shutdown. This ensures
compliance with performance criteria B acc. to EN 61326-1 and EN 61326-2-1.

Switching the instrument on and off

To switch on the R&S ZNB/ZNBT

1. Switch the AC power switch to position I (On).
The AC power switch is located in the upper part of the rear panel, together with
the mains connector and the fuse drawer (R&S ZNBT only; see Chapter 4.3, "Rear
panel R&S ZNB", on page 38 or Chapter 4.4, "Rear panel R&S ZNBT",
on page 41).
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Standby and ready state

After power-on, the analyzer automatically goes to standby or ready state, depend-
ing on the state of the standby toggle key at the front panel when the instrument
was switched off last time.

2. If necessary, press the standby toggle key on the front panel to switch the instru-
ment to ready state.
See Chapter 3.8, "Standby and ready state", on page 19
The instrument automatically performs a system check, boots the Windows® oper-
ating system and then starts the vector network analyzer (VNA) application. If it

was terminated regularly, the VNA application restores all recall sets and instru-
ment settings of the previous analyzer session.

To shut down the instrument

1. Press the standby toggle key.

Pressing the standby toggle key causes the instrument to save all loaded recall
sets, to close the VNA application, to shut down Windows®, and to go to standby
state (see Chapter 3.8, "Standby and ready state", on page 19).

Of course, you can also perform these steps manually, like in any Windows ses-
sion.

2. |If desired, set the AC power switch to position O (Off).

To disconnect from power
The R&S ZNB/ZNBT is in standby state.

1. NOTICE! Risk of data loss. If you disconnect the product from power when it is in
the ready state, you can lose settings and data. Shut it down first.
Set the switch on the power supply to position [0].

The LED of the standby toggle key key is switched off.
2. Disconnect the R&S ZNB/ZNBT from the power source.

Standby and ready state

R&S ZNB: The standby toggle key is located in the bottom-left corner of the front
panel. In standby state, the right, amber LED is on, in ready state, the left, green LED
is on.

R&S ZNBT: The standby toggle key is located in the bottom-right corner of the front
panel. In standby state, the PWR LED light is amber, in ready state it is green.

The standby power only supplies the power switch circuits and the optional oven
quartz (option R&S ZNB-B4/R&S ZNBT-B4, "OCXO Frequency Reference"). In this
state, it is safe to switch the AC power off and disconnect the instrument from the
power supply. In ready state, all modules are power-supplied. When switched to ready
state, the analyzer initiates its startup procedure.
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3.9

Windows operating system

Observe the instructions for startup and shutdown in Chapter 3.7, "Switching the instru-
ment on and off", on page 18.

Windows operating system

The analyzer is equipped with a Windows 10 operating system, which has been config-
ured according to the instrument's features and needs. Changes in the system configu-
ration can be necessary to:

e Establish a LAN connection

® Customize the properties of the external accessories connected to the analyzer
® Call up additional software tools

All necessary settings can be accessed from the Windows "Start" menu, in particular

from the "Control Panel". To open the "Start" menu, press the Windows key in the tool-
bar or on an external keyboard.

Modifications of the operating system

The operating system is adapted to the network analyzer. To avoid impairment of
instrument functions, only change the settings described in this manual. Existing soft-
ware must be modified only with update software released by Rohde & Schwarz. Like-
wise, only programs authorized by Rohde & Schwarz for use on the instrument must
be executed.

User accounts and password protection

The analyzer uses a user name and password as credentials for remote access. Two
user accounts with different levels of access are available on the instrument:

® ‘instrument" is the default account with standard rights to change system settings.
Use this account for normal operation of the analyzer.

® "Admin" is the account for administering the operating system. This account is
required, for instance, if you wish to install programs on the analyzer.
In the factory configuration, "894129" is preset as a password for both users. To
protect the analyzer from unauthorized access, it is recommended to change the
preset passwords.

To switch from one user account to another, log off from Windows and then log on
again. The "switch user" functionality is disabled on the R&S ZNB/ZNBT.

Security updates and patches

Microsoft regularly creates security updates and other patches to protect Windows-
based operating systems. They are released through the Microsoft Update website and
associated update server. Update instruments using Windows regularly, especially
instruments that connect to a network.
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3.10

Minimizing the VNA application

The analyzer is equipped with a Windows 10 loT Enterprise LTSB/LTSC operating sys-
tem, which is the embedded version of Windows 10 with long-term support for Win-
dows security updates and patches.The firmware is tested with the following OS ver-
sions:

® Windows 10 loT Enterprise 2016 LTSB
® Windows 10 IoT Enterprise 2019 LTSC
® Windows 10 loT Enterprise 2021 LTSC

Firewall settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. Rohde & Schwarz highly recommends using the firewall on
your instrument. Rohde & Schwarz instruments are shipped with the Windows firewall
enabled. All ports and connections for remote control are enabled.

Note that changing firewall settings requires administrator rights.

Virus protection

Take appropriate steps to protect your instruments from infection. Use strong firewall
settings and scan any removable storage device used with a Rohde & Schwarz instru-
ment regularly. It is also recommended that you install anti-virus software on the instru-
ment. Rohde & Schwarz does NOT recommend running anti-virus software in the
background ("on-access" mode) on Windows-based instruments, due to potentially
degrading instrument performance. However, Rohde & Schwarz does recommend run-
ning it during non-critical hours.

For details and recommendations, see the Rohde & Schwarz white paper 1EF96: Mal-
ware Protection Windows 10.

Minimizing the VNA application
With a minimized VNA application, you can access your analyzer's Windows® desktop
or run other applications.

To exit the default full-screen mode of the VNA application, deselect System — [Display]
> "View Bar" > "Title Bar Task Bar". Then use the standard Windows® title bar functions
to minimize/maximize/close the application window.

To start the VNA application with a minimized window
1. Right-click the Vector Network Analyzer shortcut icon on the desktop.
2. Open the "Properties" dialog.

3. In the "Shortcut" tab, select "Run: Minimized".
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% R&S ZNEB Vector Metwork Analyzer Properties x
Security Detailz Previous Versions
General Shortcut Compatibility

f%) RA&S ZNB Vector Network Analyzer

Target type Application

Target location: Bin

Target: |'a|7"-.\c"edur MNetwork Analyzer"-ZNB'-.Ein"-.\c"na.exa"|
Start in: | |
Shorteut key: |Nnne |
Run: | Normal window ~ |
Nomal window
Comment:
Maximized
Open File Location Change lcon.. Advanced...

Cancel Aooly

@ A software update restores the original shortcut properties.

3.11 Connecting external accessories

The analyzer's standard PC interfaces (Monitor, USB, LAN) can be used to connect
various accessories:

® An external monitor expands/displays the Windows® desktop, which is, by default,
covered by the vector network analyzer (VNA) (VNA) application window in full-
screen mode.

® External keyboard and mouse enable/simplify local control, in particular manual
(GUI) operation of the VNA application.

® A printer can be used to create hardcopies of the measurement diagrams and
traces from within the VNA application.

® A LAN connection can be established to access the analyzer's mass storage or
control the analyzer from an external PC.

® |nstruments equipped with the latest controller board can also be remote controlled
via USB.

O For the R&S ZNBT, external monitor and mouse are required for local operation. The
= R&S ZNB can be fully controlled by tapping the touchscreen and front panel keys.

3.11.1 Connecting a monitor

Connect a standard monitor to one of the monitor connectors on the rear panel of the
instrument.

DisplayPort (recent controller boards only)
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HDMI™ (2nd generation R&S ZNB only)

DVI-D (1st generation R&S ZNB and R&S ZNBT)

Select System > [Display] > "View Bar" > "Hard Key Panel On" from the menu bar of
the VNA application window to add the (virtual) "Hard Key Panel" to the application
window.

Changing the Screen Resolution (R&S ZNBT)

In case the R&S ZNBT fails to adjust the display resolution properly when an external
monitor is connected, proceed as follows:

1. Connect a USB keyboard and mouse as described in Chapter 3.11.6, "Connecting
a USB cable for remote control", on page 25.

2. Hold the [Ctrl] key and press [Esc] to show the taskbar.

3. Click the rectangular button rightmost on the task bar to show the Windows desk-
top.

4. Right-click the Windows desktop.
5. Select "Display settings" from the context menu

6. In the Windows display management

a) Change the "Multiple displays" setting to "Show desktop only on 2"; apply and
confirm the modified settings ("Keep Changes")

b) Select Display 2 in the panel at the top.

c) Change the display "Resolution" to the desired value by dragging the slider;
click "OK" and confirm the modified settings ("Keep Changes")

3.11.2 Connecting a keyboard

A keyboard can be connected to any of the USB connectors. After being auto-detected
by the operating system, it can safely be disconnected and reconnected even during
measurements.

Keyboard configuration

The default input language is English — US. Select "Settings" > "Time & language" >
"Region & language" from the Windows® Start menu to manage languages and key-
boards.

O To access Windows®, use the E button in the toolbar of the application window.
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3.11.3 Connecting a mouse

A USB mouse can be connected to any of the USB connectors. After being auto-detec-
ted by the operating system, it can safely be disconnected and reconnected even dur-
ing measurements.

Mouse configuration

Select "Settings" > "Devices" > "Mouse & touchpad" from the Windows® "Start" menu
to configure the mouse properties.

O To access Windows®, use the [ button in the toolbar of the application window.

3.11.4 Connecting a printer
A printer can be connected to any of the USB connectors. After successful installation,
it can safely be disconnected and reconnected even during measurements.
Before printing (System — [Print]), the analyzer checks whether a printer is connected
and turned on and whether the appropriate printer driver is installed.
Printer driver installation

If necessary, the printer driver installation is initiated using the operating system's "Add
Printer Wizard". The wizard is self-explanatory. A printer driver must be installed only
once.

A great variety of printer drivers is available on the analyzer. To obtain the complete
list, select "Settings" > "Devices" > "Printers & scanners" from the Windows® "Start"
menu.

O To access Windows®, use the [ button in the toolbar of the application window.

You can load updated and improved driver versions or new drivers from an installation
disk, USB memory stick or another external storage medium. Alternatively, if the ana-
lyzer is integrated in a network, you can install driver data stored in a network directory.
In either case, use the "Add Printer" wizard to complete the installation.

Printer configuration

Use the "Printer Setup" dialog of the firmware (System — [Print] > "Print...") or the Win-
dows® printer management to configure the printer properties and printing preferences.
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Remote operation in a LAN
3.11.5 Connecting a LAN cable

A LAN cable can be connected to the LAN connector on the rear panel of the analyzer.
To establish a LAN connection, proceed as follows:

1. Referto Chapter 3.12.1, "Assigning an IP address", on page 26.
2. Connect a CAT6 or CAT7 LAN cable to the LAN port.

The LAN port of the analyzer is an auto-crossover Ethernet port. You can connect it to
a network, but you can also set up a direct connection to a computer or another instru-
ment. For both connection types, you can use either crossover or straight through
(patch) cables.

The IP address information is displayed in the System — [Setup] > "Remote Settings"
softtool tab.

For the R&S ZNBT, it is also shown on the Mini display.

3.11.6 Connecting a USB cable for remote control

Instruments equipped with the latest controller board can also be remote-controlled via
USB. To prepare for remote control operation, connect a suitable USB 2.0 or 3.0 cable
to the type B "USB Device" port on the rear panel of the instrument. With direct con-
nection to a host device, a connecting cable A-B (plug type A onto plug type B) must
be used.

For more information, refer to the Remote Control chapter of your analyzer's help sys-
tem or user manual.

3.12 Remote operation in a LAN

A LAN connection is used to integrate the analyzer into a home/company network.
LAN connectivity offers several applications, e.g.:

® Transfer data between a controller and the analyzer, e.g. to run a remote control
program.

® Control the measurement from a remote computer using Remote Desktop or a sim-
ilar application.

® Use external network devices (e.g. printers).

The analyzer uses a user name and password as credentials for remote access; see
Chapter 3.9, "Windows operating system", on page 20 for details. To protect the ana-
lyzer from unauthorized access, it is recommended to change the factory setting.
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3.12.1 Assigning an IP address

Depending on the network capacities, the TCP/IP address information for the analyzer
can be obtained in different ways.

® |f the network supports dynamic TCP/IP configuration using the Dynamic Host
Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

® |f the network does not support DHCP, or if the analyzer is set to use alternate
TCP/IP configuration, the addresses must be set manually.

By default, the analyzer is configured to use dynamic TCP/IP configuration and obtain
all address information automatically. Hence it is safe to establish a physical connec-
tion to the LAN without any previous analyzer configuration.

Manual TCP/IP configuration

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before you connect the ana-
lyzer to the LAN. Contact your network administrator to obtain a valid IP address,
because connection errors can affect the entire network.

"Windows operating system", on page 20 for details.

The R&S ZNBT provides a miniature display in the upper right-hand corner of the front

@ Admin account
You need administrator rights to change the TCP/IP configuration. See Chapter 3.9,
Q panel indicating the current IP address of the instrument. See Mini display.

To enter the TCP/IP address information manually

1. Obtain the IP address and subnet mask for the analyzer and the IP address for the
local default gateway from your network administrator. If necessary, also obtain the
name of your DNS domain and the IP addresses of the DNS and WINS servers on
your network.

2. For the R&S ZNBT, connect an external monitor, keyboard and mouse.

3. Press the Windows key in the toolbar, the System keypad (R&S ZNB only) or on an
external keyboard to access Windows®.

4. Open the "Control Panel" > "Network and Sharing Center" > "Change adapter set-
tings" dialog and right-click the local connection.

5. Select "Properties" and confirm the user account control message, depending on
your current user account.

e If your current account is an administrator account, select "Yes".
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e |f your account is an account with standard user rights, enter the password of
the administrator account and select "Yes".

User Account Control X

Do you want to allow this app to make
changes to your device?

! 5- Network Connections

Verified publisher: Microsoft Windows

Show more details

To continue, enter an admin user name and password.

Admin

More choices

Yes No

Figure 3-1: User Account Control dialog

6. In the "Connection Properties" dialog opened, select "Internet Protocol Version 4
(TCP/IPv4) > Properties" and enter the IP address information.

Internet Protocol Version 4 (TCP/IPv4) Properties *
General

‘You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(") Obtain an IP address automatically
(®) Use the following IP address:

IP address: 192 . 188 . 1 . 134
Subnet mask: p55 . 255,255, 0

Obtain DNS server address automatically

(®) Use the following DNS server addresses:

Preferred DNS server: l:l

Alternative DNS server:

[ validate settings upon exit e

Cancel

3.12.2 Using computer names

In a LAN that uses a DNS server (Domain Name System server), each PC or instru-
ment connected in the LAN can be accessed via an unambiguous computer name
instead of the IP address. The DNS server translates the host name to the IP address,
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which is especially useful when a DHCP server is used, as a new |IP address can be
assigned each time the instrument is restarted.

Each instrument is delivered with an assigned computer name, but this name can be
changed. The default instrument name is a case-insensitive string with the following
syntax:

ZNB<4|8|20|26]40|43>-<variant>-<serial_number>, ZNB40-N-<serial_number>
ZNBT8-8-<serial_number>, ZNBT<20|26|40>-1-<serial_number>

The serial number can be found on the rear panel of the instrument. It is the third part
of the device ID printed on the bar code sticker:

& D: 102030

ZNB40-84-102030, or ZNBT40-1-102030, for example

Serial Number

3.12.3 Remote Desktop connection

Remote Desktop is a Windows® application which you can use to access and control

the analyzer from a remote computer through a LAN connection. While the measure-

ment is running, the analyzer screen contents are displayed on the remote computer,

and Remote Desktop provides access to all applications, files, and network resources
of the analyzer.

O At the R&S ZNB/ZNBT, by default remote connections are enabled using a local group
= policy and remote access is granted to users instrument and administrator.

For detailed information about Remote Desktop and the connection, refer to the Win-
dows® Help ("Windows Start Menu > Help and Support").
To establish a remote desktop connection, proceed as follows:

1. Connect remote Windows PC and VNA to the LAN and make sure that an IP con-
nection can be established.

2. Atthe remote Windows PC, open a remote desktop connection (type Remote
Desktop Connection at the Windows Start/Search menu and hit enter).

3. Inthe "Remote Desktop Connection" dialog, enter the VNA's computer name or IP
address and select "Connect"
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O If no external monitor is connected at the time you log in to the instrument via remote
= desktop, Windows® possibly displays the following error message:

Microsoft Windows
._@_. Unable to connect to projector

Mo projector was detected.

This message can be safely ignored.

3.12.4 Windows® firewall settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. In the default configuration of the R&S ZNB/ZNBT, the firewall
is enabled. A remote desktop connection does not require any changes in the firewall
settings.

@ Admin account
You need administrator rights to change the firewall settings. See Chapter 3.9, "Win-
dows operating system"”, on page 20 for details.

Some actions require a different firewall configuration, e.g.:
® To transfer data with other hosts in the LAN, you have to allow "File and Printer

Sharing".
To change the firewall settings, proceed as follows:

1. Access the operating system by pressing the Windows® key on the external key-
board. Open the "Control Panel".

2. Select "Windows Defender Firewall"

e Select "Allow an app or feature through Windows Defender Firewall" to enable
"File and Printer Sharing".
e Select "Turn Windows Firewall on or off" to enable or disable the firewall.

Confirm the user account control message to allow the desired changes (see Fig-
ure 3-1). For detailed information about the firewall, refer to the Windows® Help.
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Front panel R&S ZNB

4 |nstrument tour

This chapter gives an overview of the control elements and connectors of the
R&S ZNB/ZNBT and gives all information that is necessary to put the instrument into
operation and connect external devices.

The meanings of the labels on the product are described in "Meaning of safety labels"
on page 9.

4.1 Front panel R&S ZNB

The front panel of the instrument consists of the touchscreen with the diagrams and
softtool panels (left side), the hardkey area (right side) and the test port area below.
Brief explanations on the controls and connectors, the hardkey area and the rear panel
can be found on the next pages.

O Two-port and four-port network analyzers

The figures and examples in this Getting Started guide show a two-port network ana-
lyzer. Everything described in this guide is also valid for four-port analyzers. The exten-
ded measurement functionality of the four-port instruments is described in the help sys-
tem and in the user manual.

& ROHDE&SCHWARZ  (ZNB - Vector Network Analyzer - 100 kHz - 43.5 GHz

[ Trace
A v i \
LAY TIE=000n% SEEE
BMag 15 dB/Ref0 dB ~ 12 [GTH dBMag 10 dB/ Ref0 dB e 5 | T3 = —
Ccmes | E“"ﬁ"J Line lmmm}
loda- | Ma | el atios Channel
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Figure 4-1: R&S ZNB43 with four ports
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Touchscreen

The analyzer is equipped with a 12.1" diagonal WXGA, 18-bit color LCD touchscreen.
The touchscreen presents all measurement results, mostly in the form of diagrams.
Besides, all instrument functions can be accessed and operated by tapping the control
elements on the touchscreen. For an introduction to touchscreen operation, refer to
Chapter 5.1, "Manual operation", on page 44.

The following sections contain further useful information about manual control of the
instrument.

® Refer to the other sections in the chapter Chapter 5, "Operating the instrument”,
on page 44 to learn how to handle traces and diagrams, and how to use menus,
keys and softtools.

e Refer to chapter "Concepts and Features" in the user manual or help system to
obtain information about the results in the diagram.

® Refer to section "Display Menu" in the user manual or help system to learn how to
customize the screen.

® Refer to the data sheet for the technical specifications of the display.

Screen saver

The screen saver function of the operating system can be used to switch off the display
if the analyzer receives no command for a selectable period of time. The display is
switched on again if any front panel key is pressed.

To enable the screen saver, access the Windows® operating system (e.g. by pressing
the Windows key in the SYSTEM keypad) and tap "Control Panel > Power Options >
Change Plan Settings > Turn off the display".

Function keys

Most of the keys in the Trace, Channel, Stimulus, and System keypads call up a rela-
ted softtool of the analyzer GUI. Every softtool provides access to a group of related
measurement settings.

The Trace keys give access to all trace settings, to the limit check settings, and to the
marker functions including marker search.

The [Meas] settings select the measured and displayed quantity.
® The [Format] settings define how measured data (traces) are presented.
® The [Scale] settings define how traces are scaled.

® The [Trace Config] settings store traces to the memory and perform mathematical
operations on traces.

® The [Line] settings define limits for the measurement results, visualize them in the
diagrams and activate/deactivate the limit check.

® The [Marker] settings position markers on a trace, configure their properties and
select the format of the numerical readout. Markers can also be used to locate spe-
cific points on the trace, define the sweep range, and scale the diagram.
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Channel The Channel keys give access to the hardware-related (channel) settings.
‘IM) ® The [Pwr Bw Avg] settings define the power of the internal signal source, the IF
@]@]@} bandwidth, and the sweep average.

® The [Sweep] settings define the scope of measurement, including the sweep type
and the number of measured sweeps.

® [Cal] provides all functions that are necessary to perform a system error correction
(calibration).

® [Channel Config] provides functions for channel management.

® The [Trigger] settings control the start of the measurement sequence.

e [Offset Embed] provides a selection of length offset parameters to shift the mea-
surement plane.

Stimulus The Stimulus keys ([Start], [Stop], [Center], [Span]) define the sweep range, depending
. on the sweep type.

Figure 4-2: R&S ZNB system keys (left: 1st gen | right: 2nd gen)

The SYSTEM keys provide general system settings.

® [FILE] provides standard Windows® functions used to create, save, recall or print
recall sets, to copy the active screen and to shut down the application.

® The [PRINT] settings control an external printer that is used to print a hardcopy of
the current recall set.

® [File Print] is available on 2nd generation R&S ZNB only. Gives access to the
[FILE] and [PRINT] settings.

® [DUT] opens a wizard that allows you to set up a measurement by specifying the
properties of the DUT (2nd generation R&S ZNB only)

® [Applic] gives access to external software tools and optional extensions of the ana-
lyzer firmware.

e [Display] gives access to all display settings and to the functions which activate,
modify and arrange different diagrams.

® [Setup] provides general system settings which are not restricted to a particular
recall set.

® The Windows® key opens the startup menu of the Windows® operating system
from where you can perform system configurations and call up additional software
utilities.
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® [Help] opens the context-sensitive help system of the analyzer.
® [Preset] performs a preset of the instrument settings.

4.1.3 Data entry keys

The keys in the DATA ENTRY keypad are used to enter numbers, units, and charac-
ters. The data entry keys are only enabled while the cursor is placed on a data input
field in a dialog or in the Help navigation pane.

® The keys 0 to 9 enter the corresponding numbers.

® The function of the
field:

— In numeric input fields, the keys enter the decimal point and a negative sign for
the entered numeric value. Multiple entries have not effect.

and "-" keys depends on the data type of the active input

— In character input fields, the keys enter a dot and a hyphen, respectively. Both
entries can be repeated as often as desired.

® The function of the four unit keys depends on the data type of the active input field;
see Chapter 5.6, "Entering data", on page 61.

— In numeric input fields, the G/n, M/y, k/m or x1 keys multiply the entered value
with factors of 100)°, 1068, 10033 or 1 and add the appropriate physical unit. x1
is equivalent to ENTER and confirms the previous entry.

— In character input fields, the G/n, M/u, k/m keys enter the letters G, M, K,
respectively. x1 is equivalent to ENTER and confirms the previous entry.

® ESCis used to:

— Cancel entries / close dialogs without activating the entries made (equivalent to
the "Close" button).

— Close the Help system.
® ENTER s used to:

— Activate the selected active control element, e.g. a button in a dialog or a link in
the "Contents" page of the Help system.

— Confirm selections and entries made and close dialogs (equivalent to the "OK"
button).

— Compress or expand menus or the Help table of contents

® BACKSPACE deletes the last character before the cursor position or the selected
character sequence or numeric value.

4.1.4 Rotary knob

The rotary knob increases and decreases numerical values, scrolls within lists, acti-
vates controls and confirms entries. Turning or pressing the rotary knob is equivalent to
the action of the "Cursor Up" and "Cursor Down" navigation keys or of the ENTER key
in the DATA ENTRY keypad, respectively.

STEP SIZE opens an input box to select the steps (in units of the current physical
parameter) between two consecutive numerical values. The step size is also valid for
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value changes using the "Cursor Up" and "Cursor Down" keys. See also Chapter 5.6.2,
"Using the numeric editor", on page 63.

Navigation keys

The keys in the NAVIGATION keypad are used to navigate within the touchscreen and
the help system, to access and control active elements.
The "Cursor Up" and "Cursor Down" keys are used to:

® Scroll up and down in lists, e.g. among menu items, in a list of keywords, in the
Help table of contents, or in the Help index

® Navigate between table rows in diagrams. Press "OK" to toggle between navigation
mode and data entries.

® |ncrease and decrease numerical input values

"Cursor Up" (Down) become inactive as soon as the beginning of the list is reached.
"Cursor Up" (Down) is equivalent to a rotation of the rotary knob to the right (left).
The "Cursor Left" and "Cursor Right" keys are used to:

® Move the cursor to the left or right within input fields

® Navigate between table columns in diagrams. Press "OK" to toggle between navi-
gation mode and data entries.

® Compress or expand menus or the Help table of contents
® Move the highlighted item in the menu bar of the active application

ENT OK is equivalent to the action of the ENTER key in the DATA ENTRY keypad.

UNDO reverses the last action, if possible. REDO reverses the action of the UNDO
button.

Standby key

The standby toggle switch is located in the bottom-left corner of the front panel.

The key serves two main purposes:

® Toggle between standby and ready state; see Chapter 3.8, "Standby and ready
state", on page 19.

® Shut down the instrument; see Chapter 3.7, "Switching the instrument on and off",
on page 18.

Front panel connectors

The test ports and four USB connectors are located on the front panel of the R&S ZNB/
ZNBT.

Test ports
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Numbered connectors:

e type N female for R&S ZNB4 and R&S ZNB8
® 3.5 mm male for R&S ZNB20

e 2.92 mm (K) male for other R&S ZNB models

The test ports serve as outputs for the RF stimulus signal and as inputs for the mea-
sured RF signals from the DUT (response signals).

® With a single test port, it is possible to generate a stimulus signal and measure the
response signal in reflection. For a measurement example, refer to Chapter 6.2,
"Reflection S-parameter measurement", on page 78.

e \With more than one test port, it is possible to perform full two-port, 3-port, ..., or n-
port measurements; see Chapter 6.1, "Transmission S-parameter measurement”,
on page 71.
In the standard configuration, all test ports are supplied by a common source.
Four-port instruments are available with an optional second source.

@ ® Use a torque wrench when screwing RF cables on the test port connectors.
® See also Chapter 3.5, "Considerations for test setup”, on page 16.

41.7.2 USB connectors

Four high-speed Universal Serial Bus connectors of type A.

The USB ports can be used to connect:

® External PC accessories such as mouse or other pointing devices, a keyboard,
printer or external storage device (USB flash drive, CD-ROM drive etc.).

® External measurement equipment such as calibration units, power meters, signal
generators or switch matrices.

4.2 Front panel R&S ZNBT

The largest part of R&S ZNBT front panel is reserved for the test ports, with an admin-
istrative area to the right. Brief explanations on the connectors and controls and the
rear panel can be found on the next pages.
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@ ROHDE&SCHWARZ  ZNBT40 - Vector Network Analyzer - 100 kHz - 40 GHz

Figure 4-3: Front view of R&S ZNBT40 (fully equipped with the maximum 24 ports)

421 Test ports

Numbered test port connectors:

;@ ® Type N female connectors for the R&S ZNBT8. Depending on the equipped port
o options there are 4, 8, 12, 16, 20 or 24 test ports.

® 3.5 mm male connectors for the R&S ZNBT20. Depending on the equipped port
options there are 8, 12, 16, 20 or 24 test ports.

® 2.92 mm (K) male connectors for the R&S ZNBT26 and R&S ZNBT40. Depending
on the equipped port options there are 8, 12, 16, 20 or 24 test ports.

The test ports serve as outputs for the RF stimulus signal and as inputs for the mea-
sured RF signals from the DUT (response signals). With a single test port, it is possible
to generate a stimulus signal and measure the response signal in reflection. For a
measurement example, refer to Chapter 6.2, "Reflection S-parameter measurement”,
on page 78. With more than one test port, it is possible to perform full two-port, 3-

port, ..., or n-port measurements; see Chapter 6.1, "Transmission S-parameter mea-
surement”, on page 71.

If the R&S ZNBT is equipped with 8 ports or lesss, all test ports are supplied by a com-
mon source. An internal second source is automatically added if the instrument is
equipped with 12 ports or more.

@ ® Use a torque wrench when screwing RF cables on the test port connectors.
® See also Chapter 3.5, "Considerations for test setup”, on page 16.
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Connector usage

v . . TwoLEDs nextto each test port indicate the connector usage:
g’) ® &) on: connector is used as a source port
® (>~ on: connector is used as a receive port
® both LEDs on: connector is used as a bidirectional (source and receive) port

4.2.2 Administrative area

Mini display

A miniature display is provided in the upper right-hand corner of the front panel to pro-
o G vide the following instrument information:

® |P address

(ERGL R FET)

® Operational "Status" or "Error <error code>"
"OK": no error

Info: general errors (e.g. related to external devices or remote control)

Warning: setting errors (e.g. generator power out of range)
— Error <error code>: severe errors (e.g. FW boot errors, HW errors)
e Control mode:
"Local": manual interaction (e.g. via Remote Desktop)
"Remote": remote control (using a script) via a LAN or GPIB connection

USB Connectors
T3 Two USB 2.0 connectors of type A (master USB) are provided on the front panel. They
mlﬂ can be used to connect:

® External PC accessories such as mouse or other pointing devices, a keyboard,
printer or external storage device (USB stick, CD-ROM drive etc.).

® External measurement equipment such as a calibration unit, power meter, signal
generator or switch matrix.

LED controls

Above the standby toggle switch some LEDs indicate various status information:

® [ERR]: operation state; if an error occurs, the LED lights up red; for more informa-
tion on errors and troubleshooting see the R&S ZNB/ZNBT User Manual

® [LAN]: LAN error occurred

e [PWR]: power state (ready/standby); see Chapter 3.8, "Standby and ready state”,
on page 19

Standby key
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The standby key is located at the lower right-hand corner of the front panel. It serves
[ o two main purposes:

® Toggle between standby and ready state; see Chapter 3.8, "Standby and ready
state", on page 19.

e Shut down the instrument; see Chapter 3.7, "Switching the instrument on and off",
on page 18.

4.3 Rear panel R&S ZNB

This section gives an overview of the rear panel controls and connectors of the net-
work analyzer.
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Figure 4-4: R&S ZNB rear view

top = 1st generation R&S ZNB (with latest CPU board LPW11)
bottom = 2nd generation R&S ZNB (order nos. 1334.3330.xx)
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Table 4-1: Rear panel connectors available on all instruments

Index | Label Description
1 (Power Power on / off switch, see Chapter 3.7, "Switching the instrument on and off",
1/0) on page 18
2 LAN RJ-45 connector to integrate the instrument to a Local Area Network, primarily for
remote control purposes; see Chapter 3.12.1, "Assigning an IP address",
on page 26.
3 USB/ Two additional type A USB 3.0 host connectors; similar functionality as the USB con-
USB Host | nectors on the front panel (see Chapter 4.1.7.2, "USB connectors", on page 35).
4 Display- External monitor connector (DisplayPort); see Chapter 3.11.1, "Connecting a moni-
Port tor", on page 22.

(n.a. for 1st gen R&S ZNB with CPU board before LPW11)

5 USB Type B USB 3.0 device connector for remote control of the instrument (see Chap-
Device ter 3.11.6, "Connecting a USB cable for remote control", on page 25)
6 Monitor External monitor connector

e DVI-D for 1st generation R&S ZNB
e  HDMI™ for 2nd generation R&S ZNB

See Chapter 3.11.1, "Connecting a monitor", on page 22.

7 USER 25-pin D-Sub connector used as an input and output for low-voltage (3.3 V) TTL
PORT control signals
8 EXT TRIG | Two BNC connectors for 5 V TTL external trigger signals
IN / EXT
TRIG
ouT
9 REF OUT | BNC output for the internal reference frequency of the analyzer. Use this connector

to synchronize other instruments to the analyzer.

10 REF IN BNC input for an external reference frequency. Use this connector to synchronize
the analyzer to another device.

11 (System Contains the removable system drive of the instrument, containing all software
drive) (including the operating system and the VNA application) and data. Do not remove
the system drive during operation.

Option R&S ZNB-B19 provides an additional removable system drive (including
operating system and firmware).

12 (Ground The ground connector provides the ground of the analyzer's supply voltage. Use this
connector) | connector for ESD protection; see "Preventing electrostatic discharge (ESD)"
on page 17.
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Table 4-2: Optional rear panel connectors

Index | Label Description

13 Bias Tees | Two or four additional BNC inputs labeled PORT BIAS 1 ... 4 (for two-port or four-

port analyzers). The inputs can be used to apply external DC voltages (biases) to

the test ports.

® Not available for 2nd generation R&S ZNB20 and for 1st generation
R&S ZNB40 that are equipped with the new reflectometer board (order no.
1317.8015.03)

®  Optional for R&S ZNB4|8

e  Always equipped for other R&S ZNB models

® "Bias Tees", providing two or four additional BNC inputs labeled PORT BIAS
1 ... 4 (for two-port or four-port analyzers). The inputs can be used to apply
external DC voltages (biases) to the test ports.

Note that there is no additional HW or SW switch for the bias tees, i.e. the voltage is
applied to the RF port as soon as you connect the voltage source to the correspond-
ing PORT BIAS connector.

For fuse replacement, see the corresponing section in the maintenance chapter of
the user manual.

13 or R&S ZN-B15 "RFFE - GPIO Interface" (1st generation R&S ZNB only)
25-pin female connector, providing:

int |
gFeFrréa- ® 2 independent RF Front-End (RFFE) interfaces according to the MIPI® Alliance
GPIO "System Power Management Interface Specification”.
N :
Interface 10 General Purpose Input/Output (GPIO) pins.
14 Device Option R&S ZNB-B12 "Device Control" provides a PCle and a Direct Control con-
Control nector.
The Direct Control interface enables direct connections between the VNA measure-
ment bus and one or more extension devices, such as:
®  An external RFFE GPIO interface R&S ZN-Z15.
®  Switch matrices R&S ZN-Z8x.
®  Multiport calibration units R&S ZN-Z154.
15 Handler Option R&S ZN-B14, Handler 1/O (Universal Interface), providing a Centronics 36
1/0 input/output connector.
16 GPIB Option R&S ZNB-B10 provides a GPIB bus connector according to standard IEEE
488/ IEC 625.
17 DC INPUT | Option R&S ZNB-B81 "DC Inputs" provides four BNC inputs for DC measurements

(adjustable to different voltage ranges).

Match signals with 50 Q to comply with EMC directives. See also Chapter 3.5, "Consid-
erations for test setup”, on page 16.

4.4 Rear panel R&S ZNBT

This section gives an overview of the rear panel controls and connectors of the
R&S ZNBT.
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Figure 4-5: R&S ZNBT rear view

Table 4-3: Rear panel connectors available on all instruments

Index | Label Description
1 (Power Power on/off switch, see Chapter 3.7, "Switching the instrument on and off",
1/0) on page 18
2 (Fuse Fuse holder. For fuse replacement, see the corresponding section in the mainte-
holder) nance chapter of the user manual. There is no such fuse on the R&S ZNB.
3 LAN RJ-45 connector to integrate the instrument to a Local Area Network, primarily for
remote control purposes; see Chapter 3.12.1, "Assigning an IP address",
on page 26.
4 UsSB/ Two additional type A USB 3.0 host connectors; similar functionality as the type A
USB Host | USB host connectors on the front panel (see "USB Connectors" on page 37).
5 Monitor External monitor connector (DisplayPort); see Chapter 3.11.1, "Connecting a moni-
(Display- | tor", on page 22.
Port)
6 usB Type B USB 3.0 device (slave) connector for remote control of the instrument (see
Device Chapter 3.11.6, "Connecting a USB cable for remote control", on page 25)
7 Monitor External monitor connector (DVI-D); see Chapter 3.11.1, "Connecting a monitor",

(DVI-D) on page 22.

8 USER 25-pin D-Sub connector used as an input and output for low-voltage (3.3 V) TTL
PORT control signals
9 EXT TRIG | Two BNC connectors for 5 V TTL external trigger signals
IN / EXT
TRIG
ouT
10 REF OUT | BNC output for the internal reference frequency of the R&S ZNBT. Use this connec-

tor to synchronize other instruments to the analyzer.
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Index | Label Description

11 REF IN BNC input for an external reference frequency. Use this connector to synchronize
the R&S ZNBT to another device.

12 SYSTEM | Contains the removable system drive of the R&S ZNBT, containing all software
DRIVE (including the operating system and the VNA application) and data. Do not remove
the system drive during operation.

Option R&S ZNBT-B19 provides an additional removable system drive (including
operating system and firmware).

13 (Ground The ground connector provides the ground of the analyzer's supply voltage. Use this
connector) | connector for ESD protection; see "Preventing electrostatic discharge (ESD)"
on page 17.
14 Digital I/0 | Used to connect an external Handler 1/O (option R&S ZNBT-Z14), providing a Cen-

tronics 36 input/output connector.

Table 4-4: Optional rear panel connectors

Index | Label Description
15 DC INPUT | Option R&S ZNBT-B81"DC Inputs" provides four BNC inputs for DC measurements
(adjustable to different voltage ranges).
16 Device This slot can be equipped with option R&S ZNBT-B12, providing a PCle and a Direct
Control Control connector.
17 GPIB Option R&S ZNBT-B10 provides a GPIB bus connector according to standard IEEE
488 / IEC 625.

Match signals with 50 Q to comply with EMC directives. See also Chapter 3.5, "Consid-
erations for test setup"”, on page 16.
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5 Operating the instrument

The following sections describe the basics of manual operation, i.e. how to access
instrument functions and settings via the analyzer GUI. Manual operation is particularly
useful for getting to know the instrument and for trouble shooting.

Manual and remote control of the instrument

In contrast to the R&S ZNB, the R&S ZNBT is primarily intended to be remote-control-
led via the GPIB or LAN interface (see chapter 'Remote Control' in the user manual).
However, all instruments can be controlled manually, either using touchscreen and
front panel keys (R&S ZNB only), an external monitor in combination with a mouse
(see also Chapter 3.11, "Connecting external accessories", on page 22) or via Remote
Desktop (see also Chapter 3.12, "Remote operation in a LAN", on page 25).

To their full extent, manual operation and remote control are described in the GUI Ref-
erence and Command Reference chapters of the user manual, respectively. GUI func-
tions and related remote commands are linked bidirectionally. Background information
is provided in the Concepts and Features chapter of the user manual.

5.1 Manual operation

The analyzer functions are accessible via several tabbed softtools, each presenting
related functions and settings. The function keys on the front panel (R&S ZNB only) or
the on-screen "Hard Key Panel" open the most frequently used softtools.

Manual operation via function keys and softtools provides touch-friendly access to the
instrument functions and settings, avoiding complicated menu structures and long
operating sequences. In general, this approach is recommended. However, sometimes
the toolbar or an object's context menu can offer a shortcut. As a full-fledged alterna-
tive for manual operation via mouse and keyboard, also the menu bar provides access
to all instrument functions and settings.

Figure 5-1: Function Keys
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O Customizing the screen

The contents of the screen and the size and position of many display and control ele-
ments are not fixed. You can display or hide most elements. You can also drag and
drop traces, info fields, and even the softtool panel to your preferred position; see
Chapter 5.5.4, "Using drag and drop", on page 61.

For example, you can show/hide the on-screen hardkey panel by selecting/deselecting
"Display" > "View Bar" > "Hard Key Panel On" from the main menu.

Using (Virtual) Hardkeys

To access an instrument function:

1. Press a (virtual) key, e.g. the [Meas] key in the Trace section.

The corresponding softtool expands at the current docking position.

Meas X

S5-Parameter 5.

E Params
hd

Ratios
512
Wave

Inter-
mod.
Al
S-Params 7e-si
5-Param
Wizard... L en
Y-Sij

Y- 7-
Params
Imbal.
CMRR

Stability

2. Activate the desired softtool tab, e.g. "Z<Sij".
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3. Select a control element, e.g. "Z—S11".

The diagram immediately reflects your selection. The active trace shows the mea-
surement results for the selected measured quantity.

A control element with three dots (e.g. System — [Setup] > "Setup" > "System Con-
fig...") opens a dialog, containing a group of related settings, a wizard or additional
information.

4'2# System Config
Presets Calibration UserInterface Messages ChannelBits Advanced Powe P

Preset Scope Remote Preset Configuration Global Settings

Align *Rst to User Use Default

Instrument U Defined Preset Directories

— c Reset Printer
() Active Se c
() Active Setup Page Setup
Pre iguration

Set Factory
Preset

Instrurment Start

|:| Start in Preset

x Close o Help

Using the menu bar

The menu bar at the bottom of the application screen provides alternative access to all
instrument functions. To repeat the measured quantity selection described above,

» Select Trace — [Meas] > "ZSij" > "Z«S11".
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The diagram immediately reflects your selection. The active trace shows the mea-
surement results for the selected measured quantity. At the same time, the related
softtool tab is opened.

Using context menus

Context menus are another alternative for quick access to instrument settings.

1. Touch and hold (right-click) the measured quantity section in the trace info for a
couple of seconds until the context menu appears.

Trel PAREIRN Lin Mag 25 0/ Ref250 0

511
512
521
522

S-Parameter...

b1fal Src Port 1

b2/fa1 Src Port 1

b2 Src Port 1
a2 Src Port 2

\ More Wave Quantities...

Meas

5-Parameter

All
S-Params

S-Param .
Wizard... IK
Balanced Ports

N
® 6 606

3. Select "ZSij" > "Z—~S11".
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5.2 Control elements of the application window

The application window of the analyzer provides all control elements for the measure-
ments and contains the diagrams for the results. There are several alternative ways for
accessing an instrument function:

® Using a function key on the (virtual) hardkey panel to open the related softtool (rec-
ommended, provides all settings)

® Using the menus and submenus of the menu bar (alternative to the previous
method)

® Using the context menus of certain display objects (for important actions in the
context of this object)

® Using the icons in the toolbar above the diagram area (for frequent global actions)
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Application System Help Ch1: Avg Nene

These methods are described in more detail in the following sections.

Title bar

By default, the analyzer GUI is shown in full screen mode, covering the whole screen
and hiding the Windows taskbar. However, you can toggle the full screen mode using
System — [Display] > "View Bar" > "Title and Task Bar On".

If full screen mode is switched off, the main application window of the vector network
analyzer application provides a standard Windows® title bar.

% Rohde & Schwarz VMNA - m} x

Toolbar

The toolbar above the diagram area contains the most frequently used control ele-
ments of the user interface. All controls are also accessible via Softtools.

'd Q'Q ><ﬂr.-1hr+m%‘0{}ﬁ:{;

The toolbar is divided into several icon groups, separated by vertical lines.
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These icons represent the undo and redo actions that are also available
“j c’ via the menu bar items "System" > "Undo" / "Redo".

Undo reverses the last action, redo reverses the last undo action (if possi-
ble).

m These icons control the zoom function (Trace — [Scale] > "Zoom").
A
W

If multiple diagrams are configured, this icon toggles the "Maximize Dia-
gram" action for the active diagram (System — [Display] > "Diagram” >
"Maximize Diagram").

i These icons implement the following actions, from left to right:
_:.f"\ v m ® Add a clone of the active trace to the active diagram (single tap; same
< t as Trace — [Trace Config] > "Traces" > "Add Trace") or to an

arbitrary/new one (drag & drop the "Trc+" icon to the diagram area).

®  Add a new marker to the active diagram (single tap; similar to Trace —
[Marker] > "Markers" > "Mkr<i>") or to an arbitrary one (drag & drop
the "Mkr+" icon).

® Delete the active trace (single tap the trash icon), or an arbitrary trace
(drag & drop its trace info field to the trash icon). Or delete all markers
of a trace (drag & drop the marker info field to the trash icon).

These icons provide the following actions, from left to right:

®  Print the current diagrams to a bitmap file (same as System — [File] >
"Print" > "To File...").
By default, all diagrams are printed, no matter if displayed or not.
However you can also choose to print only the active diagram (see
System — [File] > "Print" > "Print...").
Open the Windows® Start menu.

®  Open the context-sensitive help.

® Restart the sweep in all channels (same as Channel — [Sweep] >
"Sweep Control" > "Restart Sweep")

These icons provide the following actions, from left to right:
E '\ﬁ ® Toggle advanced diagram area editing, which makes rearranging
R and/or deleting diagrams a breeze.

®  Toggle other measurements (except the active trace) OFF|ON

®  Open the "METAS Reconnection" dialog
This button is only visible if, option R&S ZNB/ZNBT-K50 "Measure-
ment Uncertainty Analysis™ is installed. It is only enabled, if a METAS
calibration is active.

Opens the SCPI recorder

O You can hide the toolbar using System — [Display] > "View Bar".

5.2.3 Softtools

Softtools display groups of related settings as a tabbed panel. They can be opened via
function keys on the front panel (R&S ZNB only) or the on-screen "Hard Key" panel, or
via menu bar and context menu items.
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Diagram

Figure 5-2: Scale softtool

A softtool consists of a title area with a close/re-open icon and a tabbed panel below it.
The title area remains displayed when the softtool is closed, which allows you to
reopen a closed softtool at any time.

Some controls on the softtool tabs allow you to read and modify settings (e.g. "Ref
Value" in the screenshot above), some perform actions (e.g. "Auto Scale Trace"), while
others open additional dialogs (button label ends with "...").

Menu bar

You can also access the analyzer functions via textual menus. The menu bar is located
below the diagram area:

File Trace Channel Display Application System Help

As in any Windows® application, menus can be controlled with the touchscreen
(R&S ZNB only) or a mouse. A short tap (left mouse click) expands a menu or sub-
menu. If a menu command has no submenu assigned, a short tap (left mouse click)
opens a dialog, or directly activates the menu command. When a (sub)menu is
selected, the R&S ZNB/ZNBT displays the corresponding softtool.

Overview of menu functions

® The "File" menu provides functions to handle recall sets and trace files, to print or
save diagram content, and to shut down the VNA application.

® The "Trace" menu provides all trace settings, the limit check settings, and the
marker functions including marker search.

® The "Channel" menu provides all channel settings and activates, modifies or stores
different channels.
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® The "Display" menu provides all display settings and the functions for activating,
modifying and arranging different diagrams.

® The "Application"” menu gives access to applications and tools that extend the func-
tionality of the analyzer firmware.

® The "System" menu provides functions that can be used to return to a defined
instrument state, reverse operations, access service functions and define various
system-related settings.

® The "Help" menu provides assistance with the network analyzer and its operation.

O You can toggle the visibility of the menu bar using System — [Display] > "View Bar" >
= "Menu Bar".

5.2.5 Menu structure

All menus show an analogous structure.
/!\ Max
g/ Min
Mkr 1

Mikr 2 F\A Next Peak

g ]\ Peak Left

LS ’/‘\: Peak Right
Ref Mikr
Markers

Meas Marker Props

Format Marker Search

Scale Multiple Peak

Trace Config Target Search

Lines Bandfilte

Marker Set by Marker

File ' Trace Channel Displ: Info Field

® A menu command with a right arrow expands a submenu with further related set-
tings.
Example: "Marker" expands a submenu with marker-related properties.

® A menu command with three dots appended calls up a dialog providing several
related settings.
Example: "Search Range" opens a dialog to define the search range for the
marker search.

® A menu command with no arrow or dots initiates an immediate action.
Example: "Max" sets the active marker to the maximum of the active trace.
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5.2.6 Hardkey panel

The (virtual) "Hard Key" panel provides on-screen access to the function keys (plus the
[Undo] and [Redo] key) that are available at the front panel of a R&S ZNB. Most of the
function keys open a related softtool. For a short description, refer to section Chap-

ter 4.1.2, "Function keys", on page 31.

Trace
Meas Format

Trace
Config

Scale
Line Marker

Stimulus

Start Stop

Center  Span

Channel
Channel Swee
Config weep

Power

Bw Avg Trigger

Offset

Gl iz

Systemn

File Print

Display  Setup

Applic  Preset

O The "Hard Key" panel is particularly useful if the analyzer is controlled from an external
= monitor or Remote Desktop.

For the R&S ZNB, it is hidden by default, for the R&S ZNBT it is visible by default.

You can display the "Hard Key" panel using one of the following methods:

® Select System — [Display] > "View Bar" > "Hard Key Panel".

® Select "Display"> "View Bar" > "Hard Key Panel On" from the menu bar.
® Select "Hard Key" from the context menu of the softtool panel.

5.2.7 Status bar

The status bar shows:
® The active channel

® The current channel's sweep averaging counter (e.g. "Ch<i>: Avg 9/10"), or "Ch<i>:
Avg None" if averaging is disabled

® The progress of the sweep
The progress bar also shows when the R&S ZNB/ZNBT prepares a sweep with
new channel settings

® The "EXT REF" symbol, if an external reference clock is used for synchronization
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® A symbol for redefined S-parameters, if the physical ports have been redefined

® The switch matrix status symbol, if a switch matrix is configured
(See the R&S ZNB/ZNBT User Manual)

® The current date and time

Ch1: Avg None 1/2/2018 6:33:23 PM

Figure 5-3: R&S ZNB/ZNBT with redefined physical ports

Ch1: Avg Mone 1/3/2018 6:33:23 PM

Figure 5-4: R&S ZNB/ZNBT with switch matrix

The progress bar shows a moving color gradient if the current sweep is too fast to be
monitored, e.g. because the number of sweep points is low. You can hide/show the sta-
tus bar using System — [Display] > "View Bar" > "Status Bar".

Touchscreen gestures

R&S ZNB model variants with order nos 1334.3330.xx are equipped with capacitive
screens, which allow for multi-touch gestures.

A touchscreen allows you to interact with the software using various finger gestures on
the screen. The basic gestures supported by the software and most applications are
described here. Further actions using the same gestures may be possible.

Tapping

Touch the screen quickly, usually on a specific element.

You can tap most elements on the screen; in particular, any elements you can also
click on with a mouse pointer.

Figure 5-5: Tapping

Double-tapping
Tap the screen twice, in quick succession.

Double-tap a diagram to maximize it or to restore its original size.
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Dragging
@ Q Move your finger from one position to another on the display, keeping your finger on
the display the whole time.

Q {} By dragging your finger over a table or diagram you can pan the displayed area of the
table or diagram to show results that were previously out of view.

Figure 5-6: Dragging

Spreading and pinching two fingers

Move two fingers apart on the display (spread) or move two fingers together on the dis-
play (pinch).

These gestures take effect for diagrams only. The effect depends on the current zoom
mode (see Chapter 5.7, "Scaling diagrams", on page 65).

N/
& O

® |n graphical zoom mode, when you spread two fingers in the display, you graphi-
cally zoom in vertically.

Figure 5-7: Pinching

While "Zoom Select" is active (toolbar icon or softtool button is toggled on), spread-
ing and pinching is disabled. You can only select a rectangular area (using one fin-
ger) then.
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® |n stimulus zoom mode, spreading and pinging is disabled by default. Only while
"Stim. Zoom Select" is active (toolbar icon or softtool button is toggled on), you can
use spreading and pinching to modify the sweep area and/or the vertical scaling.

Mouse vs. touch actions

Any user interface elements that react to actions by a mouse pointer also react to fin-
ger gestures on the screen, and vice versa. The following touch actions correspond to
mouse actions:

Table 5-1: Correlation of mouse and touch actions

Mouse operation Touch operation

Click Tap

Double-click Double-tap

Click and hold Touch and hold

Right-click Touch, hold for 1 second and release

Drag&adrop (= click and hold, then drag and release) | Touch, then drag and release

n.a. (Change hardware settings) Spread and pinch two fingers

Mouse wheel to scroll up or down Swipe

Dragging scrollbars to scroll up or down, left or right | Swipe

In (graphical) zoom mode only: dragging the borders | Touch, then drag and release
of the displayed rectangle to change its size

Example:

You can scroll through a long table in conventional mouse operation by clicking in the
table's scrollbar repeatedly. In touchscreen operation, you would scroll through the
table by dragging the table up and down with your finger.

5.4 Working with dialogs

Dialogs provide groups of related settings and allow to make selections and enter data
in an organized way. The settings are visualized, if possible. An example is shown
below.
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":Q Balanced Ports
Predefined Config User Config Reference Impedance

Physical Ports Logical Port Property (L1)

p1 p2 Single Ended Mode

Real(Z0) Imag(Z0) Connector D Use

Renormalization According to

levant if Im({Z0) of

Logical Ports (®) Travelling Waves Rl

{_) Power Waves

v OK Cancel (@) Help

All dialogs are operated in a similar way.

® To open a dialog, select a softtool button with three dots appearing in its label (e.g.
"Start... (Manual)").

® The title bar of each dialog contains some convenience functions:

— Use the "Dialog Transparency" function to make the display elements behind
the dialog visible.

Dialog Transparency

Note: The "Dialog Transparency" is a global setting, i.e. it applies to all dialogs.
— Use the [ icon to create a screenshot of the dialog.
® Drag and drop the lower right corner of the dialog to modify its size.

® Some dialogs are subdivided into tabs, containing groups of related settings. Acti-
vate a tab to access those settings.

O The Help system provides useful information about each dialog's specific settings.
= Select "Help" to open the Help.

5.5 Handling diagrams, traces, and markers

The analyzer displays measurement results as traces in rectangular diagrams. Markers
are used to read specific numerical values and to search for points or regions on a
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trace. The following section presents some of the graphical tools the R&S ZNB/ZNBT
provides for trace and marker handling.

O For further reference

Refer to chapter "Concepts and Features" in the R&S ZNB/ZNBT Help or in the User
Manual to learn more about traces, channels, and screen elements.

5.5.1 Adding new traces and diagrams

A new trace is required if you want to measure and display an additional quantity.

Typical scenario: The transmission coefficient S, is measured as described in Chap-
ter 6.1, "Transmission S-parameter measurement"”, on page 71. A trace is added to
display the reflection coefficient Sy, for comparison.

To create a trace:
Tre4

1. Drag the "Trc+" icon from the toolbar into a diagram.

The diagram changes its color scheme and contents as shown below.

2. Select the adequate drop position, depending on whether you want to display the
new trace in the existing diagram, or whether you want to add a new diagram. The
highlighted area indicates the target diagram.

1 |31l dB Mag 10 dB/Ref 0 dB

. Split horizontally,
SRS add frace above [N

Split vertically, Add trace in Split vertically,
add trace to the existing diagram add trace to the
left right

Split horizontally,
add trace below

Start 100 kHz Pwr -10dBm Stop 8.5 Ghg

Getting Started 1316.0062.02 — 66 58



R&S®ZNB/ZNBT Operating the instrument

Handling diagrams, traces, and markers

3. In the dialog box that is opened when you release the "New Trace" icon, select the
S-parameter to be measured.
For a four-port analyzer:

4-:# New Trace

Select S-Parameter for the new trace

511 512

521 522

The R&S ZNB/ZNBT generates a new trace for the selected S-parameter.

O Alternative control elements

To measure a different quantity, select Trace — [Meas]. Drag and drop a softkey repre-
senting a measured quantity to create a trace. Or simply select another softkey to
change the measured quantity of the active trace.

Select Trace — [Trace Config] to access more trace handling functions. Select System
— [Display] to access more diagram handling functions.

5.5.2 Adding new markers

A marker is needed, for instance, to read a particular numerical trace value.

v To add a new marker:

' ® Drag and drop the "New Marker" icon from the toolbar to the desired position in the
target diagram.

EEEEED %
Trc1 [530 B Mag 2 dB/ Ref-10 dB 1w

The marker appears on the target diagram's active trace. The marker info field dis-
plays the stimulus value (x-axis value) and response value (y-axis value) at the
marker position. The response value varies as the analyzer continues performing
sweeps.
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Trl dB Mag 2 dB/Ref-10 dB

Chl Start 10 MHz

O Active trace, alternative control elements

The trace line of the active trace in the upper part of the diagram is highlighted. If the
diagram contains several traces, first activate the target trace, then add the marker.

The Trace — [Marker] softtool provides more functions for marker handling. In particu-
lar, any marker offered in the "Markers" tab can be positioned on the active trace using
drag & drop.

5.5.3 Deleting display elements

Markers, traces, diagrams, and other display elements are most conveniently deleted
using the "Delete" icon in the toolbar above the diagram area.

® To delete a single marker, drag it into vertical direction to release it from the trace
and drop it onto the "Delete" icon.
To delete a set of markers, drag and drop their marker info field onto the "Delete"
icon.
Deleting a marker and its info field also disables the associated marker function.

® To delete a trace, drag and drop its trace line onto the "Delete" icon. The active
trace can also be deleted by tapping/clicking the "Delete" icon.
Note however, that the last remaining trace cannot be deleted.

® To delete a diagram, drag and drop its diagram number label onto the "Delete"
icon.
Note however, that the last remaining diagram cannot be deleted.

® To delete a channel, drag and drop all associated traces onto the "Delete" icon.
Note however, that the last remaining channel cannot be deleted.

® To hide the limit lines and disable the limit check, drag and drop the PASS / FAIL
message onto the "Delete" icon. The limit line itself is not deleted and can be
reused.

The context menu of some display elements also provides the "Delete" function.
O Undo function

If you happen to delete a display element unintentionally, you can restore it using the
"Undo" toolbar icon.
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5.5.4 Using drag and drop

You can drag and drop many of the R&S ZNB/ZNBT's control and display elements to
change their size and position. The drag and drop functionality is often more conven-
ient to use than the equivalent buttons of the softtool panels. The following table gives
an overview.

Table 5-2: Drag and drop functionality for various screen elements

Screen element Action Drag and drop...

Diagram Create See Chapter 5.5.1, "Adding new traces and diagrams", on page 58
Resize Separator between adjacent diagrams
Delete See Chapter 5.5.3, "Deleting display elements", on page 60

Trace Create See Chapter 5.5.1, "Adding new traces and diagrams", on page 58
Move vertically Reference line marker (right diagram edge)

Move into other or new | Trace line

diagram
Delete See Chapter 5.5.3, "Deleting display elements", on page 60
Reset / suspend "Zoom" element in additional trace line --> "Delete" icon; see Chapter 5.7.1,
graphic zoom "Using the graphical zoom", on page 65
Marker Create See Chapter 5.5.2, "Adding new markers", on page 59
Move horizontally Marker symbol
Delete Marker or marker info field --> "Delete" icon; see Chapter 5.5.3, "Deleting display
elements”, on page 60
Marker info field Add See Chapter 5.5.2, "Adding new markers", on page 59

Move within diagram Marker info field (move to one of several predefined positions)

Delete See Chapter 5.5.3, "Deleting display elements", on page 60

5.6 Entering data

The analyzer provides dialogs with various types of input fields where you can enter
numeric values and character data. Data entry with a mouse and an external keyboard
is a standard procedure known from other Windows® applications. However, there are
various other ways to enter data.

5.6.1 Using front panel keys

On a R&S ZNB, you can use the keys in the data entry keypad to enter numbers, units,
and characters.
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To enter a numeric value:

1. Select a numeric data input field to activate it.

2. Press the data entry keys.

Use [0] to [9] to enter the corresponding numbers.

Use [.] to enter a decimal point.

Use [-] to change the sign of the value.

Use [G/n], [M/u], [k/m], or [x1] to multiply the entered value with factors of 100)°,
1008, 1063 or 1 and to add the appropriate physical unit.

To enter a character string:
1. Tap a character data input field to activate it.

2. Press the data entry keys as if you were writing a short message on your mobile
phone.

e Use [0] to [9] to enter the corresponding numbers.

e Use [.] and [-] to enter a dot or hyphen.

e Use [G/n], [M/u], or [k/m] to enter the letters G, M or K (case-insensitive).

e Use the B key to correct wrong entries, deleting the character to the left of the
current cursor position.

Press & to complete an entry.

Press [Esc] to discard the entries made.

3. To enter letters other than G, M or K, you can also use one of the methods descri-
bed in the following sections:

e Chapter 5.6.3, "Using the analyzer's on-screen keyboard", on page 63
e Chapter 5.6.4, "Using the Windows® on-screen keyboard", on page 64
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5.6.2 Using the numeric editor

The "Numeric Editor" is a tool for convenient entry and modification of numeric values.
It is available for all numeric input fields in the analyzer GUI.

Operation with touchscreen or mouse:

1. Double-tap (double-click) a numeric input field in a dialog or on a softtool to open
the numeric editor.

Auto

2. Use the buttons in the numeric keypad to enter a value.

3. Use the cursor up/down buttons to increment/decrement the value by the current
"Step Size".

4. |If the active trace has markers with suitable unit for the stimulus or response, you
can set the numeric value to one of these stimulus/resonse values ("Set to
Marker").

5. After completing the input, select "ENTER" to apply the new value and close the
editor.

O [Step Size] key
S If a numeric input field is active, the [Step Size] front panel key opens a dialog box con-
taining the "Step Size" panel of the numeric editor. Use this box for efficient operation
of the rotary knob (and mouse wheel).

5.6.3 Using the analyzer's on-screen keyboard

The on-screen "Keyboard" allows you to enter characters, in particular letters, without
an external keyboard. It is available for all text input fields in the analyzer GUI.
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1. Activate a character data input field in a softtool or a dialog.
Double-tap/click the input field to open the on-screen keyboard.

Select character buttons to compose the input string.

A w0 DN

Select "Enter" to apply your selection and close the keyboard.

5.6.4 Using the Windows® on-screen keyboard

The Windows® on-screen keyboard allows you to enter characters, in particular letters,
even if an input field cannot call up the analyzer's own on-screen keyboard. Examples
are input fields in standard Windows ® dialogs.

Home PgUp
End PgDn
Insert Pause
PrtSen  Scrlk

Alt  Ctrl < v > Options He|p

Figure 5-8: Windows 10 on-screen keyboard

To call up the on-screen keyboard:
1. Open the System — [Applic] softtool.
2. Select "External Tools"

3. Select "Screen Keyboard".
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5.7 Scaling diagrams
The analyzer provides various tools for customizing the diagrams and for setting the

sweep range. Choose the method that is most convenient for you.

5.7.1 Using the graphical zoom

The graphical zoom function magnifies a rectangular portion of the diagram (zoom win-
dow) to fill the entire diagram area. The sweep points are not affected.

O The graphical zoom function is only supported for cartesian trace formats. For (inver-
= ted) Smith and polar diagrams, it is not available.

E To activate the graphical zoom:

® Select the "Zoom Config" icon in the toolbar above the diagram area and make
sure that the graphical zoom mode is active:

timulus

E Open Zoom 5oft Tool
® Select the "Zoom Select" toggle button in the toolbar above the diagram area.
The icon changes its background color from black to blue.
® |n the active diagram area, select an appropriate rectangular area.

The zoomed view shows the selected rectangle, scaled in both horizontal and verti-
cal direction. In general, the zoom window covers only a part of the sweep range;
the horizontal distance between the sweep points increases. The reduced display
range is indicated in an additional zoom line in the channel info area.
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Chl Start 1GHz hwr Stop 6GHz

Start 3.92 GHz Zoo| C Stop 5.96 GHz

Use the "Zoom Reset" icon to restore the original diagram. Alternatively, you can drag
and drop the "Zoom" label from the additional channel info line onto the [ toolbar but-
ton.

Alternative settings

® The Trace — [Scale] > "Zoom" softtool tab allows you to define the displayed zoom
range numerically.
It can also be opened from the menu of the "Zoom Config" toolbar icon.

aQ)

® |f the active diagram is graphically zoomed, "Overview On" in the "Zoom" softtool
tab toggles an overview. The upper part of the diagram then shows a small version
of the unzoomed diagram. You can move the zoomed part of the trace by moving
the rectangular area in the overview.

Start 4.51GHz — == Zoom Trc3TrcdTre5 3.2 dB/ Stop  5.53 GHz

® To zoom the stimulus range (keeping the number of sweep points constant), use
the "Zoom Config" toolbar icon and select "Mode Stimulus Zoom". Then use the
"Zoom Select" icon to narrow the sweep range and adjust the vertical scaling.

5.7.2 Setting the sweep range

The sweep range for all related channels is displayed in the channel info area at the
bottom of each diagram:
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To change the sweep range of the active channel, use one of the following methods:

® Use the [Start], [Stop], [Center], and [Span] function keys from the Stimulus sec-
tion.

® Double-tap (with a mouse: double-click) the "Start" or "Stop" label in the channel
list.

® Tap and hold (with a mouse: right-click) the "Start" or "Stop" label in the channel list
and select "Start Frequency", "Stop Frequency", "Center Frequency", or "Fre-
quency Span" from the context menu.

® Select "Start Frequency", "Stop Frequency", "Center Frequency", "Span Fre-
quency" from the "Channel" > "Stimulus" menu.

® Use the "Set by Marker" functions (Trace — [Marker] > "Set by Marker"; see Chap-
ter 5.7.6, "Set by marker", on page 68).

Reference value and position

The analyzer provides three parameters for changing the scale of the vertical
(response) axis:

® Changing the "Ref Value" or "Ref Pos" shifts the trace in a vertical direction and
adjusts the labels of the vertical axis. "Ref Value" also works for radial diagrams.

® Changing the "Scale/Div" modifies the value of the vertical or radial diagram divi-
sions and thus the entire range of response values displayed.

The "Scale/Div" and the "Ref Value" are indicated in the scale section of the trace info.
In the example below, a "Scale/Div" of 10 dB and a "Ref Value" of 0 dB is used.

Trc1 B0 dBMag 10 dB/RefOdB Math

To change such a scale parameter, use one of the following methods:
® Open the Trace — [Scale] > "Scale Values" softtool tab and proceed from there.

® Tap and hold (with a mouse: right-click) the scale section in the trace info and
select a setting from the context menu.

® Select a setting from the "Trace" > "Scale" menu.

® Use "Set by Marker" functions (Trace — [Marker] > "Set by Marker"; see Chap-
ter 5.7.6, "Set by marker", on page 68).

Auto scale

The "Auto Scale" function adjusts the scale divisions and the reference value so that
the entire trace fits into the diagram. To access "Auto Scale", use one of the following
methods:

® Open the Trace — [Scale] > "Scale Values" softtool tab and select "Auto Scale
Trace" or "Auto Scale Diagram".

® Tap and hold (with a mouse: right-click) the scale section in the trace info and
select "Auto Scale Trace" from the context menu.
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® Select "Auto Scale Trace" or "Auto Scale Diagram" from the "Trace" > "Scale"
menu.

5.7.5 Circular diagrams

The radial scale of a circular diagram ("Polar", "Smith" or "Inverted Smith") can be
changed with a single linear parameter, the "Ref Value". The reference value defines
the radius of the outer circumference.

® Increasing the "Ref Value" scales down the polar diagram.
® Decreasing the "Ref Value" magnifies the polar diagram.

The "Ref Value" is indicated in the scale section of the trace info.

To change the "Ref Value" setting, use one of the following methods:
® [ ocate it on the Trace — [Scale] > "Scale Values" softtool tab.

® Tap and hold (with a mouse: right-click) the scale section in the trace info and
select the parameter from the context menu.

® Select the parameter from the "Trace" > "Scale" menu.

® Use the "Set by Marker" functions; see Chapter 5.7.6, "Set by marker",
on page 68.

5.7.6 Set by marker

The "Set by Marker" functions are a convenient tool for scaling (in particular: magnify-
ing) diagrams without entering explicit numeric values. You simply place a marker to a
trace point and use the marker values to change the sweep range or move the trace
relative to the vertical axis. The touchscreen or a mouse makes it easier to activate
(touch/click) or move (drag and drop) markers.

Marker

Center =
Marker

RefVal=
Marker
Start=
Marker
Stop =
Marker

Max =
Marker

=il = =1 BBl

Min=
Marker

>

Set by
Marker

To set the sweep range using markers, use one of the following methods.
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Set "Start" and "Stop" values in the diagram:

1. Create two normal markers, e.g. the markers "Mkr 1" (default label "M1") and "Mkr
2" (default label "M2").
See Chapter 5.5.2, "Adding new markers", on page 59.

2. Place "M1" to the start value of the desired sweep range and tap Trace — [Marker]
> "Set by Marker" > "Start = Marker".

3. Place "M2" to the stop value of the desired sweep range and tap Trace — [Marker]
> "Set by Marker" > "Stop = Marker".

Use a definite "Span:"
1. Create a marker.

2. Enable "Delta Mode" for this marker.
The analyzer automatically creates an additional reference marker.

3. Place the reference marker to the start value of the desired sweep range.

4. Set the value of the delta marker to the desired sweep range and tap Trace —
[Marker] > "Set by Marker" > "Span = Marker".

To move the trace in a vertical direction, proceed as follows:
1. Create a normal marker, e.g. the marker "Mkr 1" (default label "M1").

2. Place "M1" to a particular trace point, e.g. use the "Marker Search" functions to
locate a maximum or minimum on the trace.

3. Select Trace — [Marker] > "Set by Marker" > "Max = Marker" to move the trace
towards the upper diagram edge, leaving the values of the vertical divisions
("Scale/Div") and the overall vertical scale unchanged. Analogously, select "Min =
Marker" to move the trace towards the lower diagram edge, or select "Ref Val =
Marker" to move the trace towards the "Ref Value".

O You can also use marker values in the "Numeric Editor"; see Chapter 5.6.2, "Using the
= numeric editor", on page 63.

5.7.7 Enlarging a diagram

The analyzer provides different tools for customizing the contents and size of the dia-
grams:

® Select B from the toolbar to maximize the active diagram. Or, equivalently, select
System — [Display] > "Diagram" > "Maximize Diagram".
If enabled the active diagram is always maximized.

® Double-tap/click a diagram to maximize it and make all its traces except the active
one invisible

® The "Menu Bar", the "Status Bar", the "Hard Key Panel", and the "Title Bar" can be
hidden to gain space for the diagrams (System — [Display] > "View Bar").
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Scaling diagrams

® The System — [Display] > "Config" softtool tab defines optional display elements for
the interior of the diagrams.

Use the context menu of the diagram, the System — [Display] key or the "Display"
menu to access the display settings.
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6 Performing measurements

This chapter takes you through a sample session with a R&S ZNB/ZNBT network ana-
lyzer and describes basic operation tasks.

in Chapter 3, "Preparing for use", on page 14.

Use the "S-Parameter Wizard" accessible via Trace — [Meas] > "S-Params" > "S-
Param Wizard..." to measure S-parameters in a straightforward way. The wizard pro-
vides a series of dialogs where you can select the test setup, screen configuration and
measurement parameters, configure the essential channel settings and perform a gui-
ded calibration.

@ Prerequisite
The instrument is set up, connected to the mains system, and started up as described

Measurement stages in the wizard

The individual dialogs of the "S-Parameter Wizard" correspond to the typical stages of
any measurement:

1. Select the test setup.
Define port impedances.
Select the measurement parameters and the diagrams.

2

3

4. Define the sweep range.

5. Adjust the receiver and source settings (measurement bandwidth, source power).
6

Perform a calibration.

6.1 Transmission S-parameter measurement

In a transmission measurement, the analyzer transmits a stimulus signal to the input
port of the device under test (DUT) and measures the transmitted wave at the DUT's
output port. The trace settings allow you to select the measured quantities and display
formats, depending on what you want to learn from the data. A minimum of two ana-
lyzer test ports are required for transmission measurements.

In the following example, the analyzer is set up for a two-port transmission measure-
ment. A frequency sweep range is selected, the instrument is calibrated and the mea-
surement result is analyzed using various display formats.

6.1.1 Connecting the instrument for transmission measurements

To prepare a transmission measurement, you have to connect your DUT (which for
simplicity we assume to have appropriate connectors) in-between a pair of analyzer
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test ports. It is recommended that you preset the R&S ZNB/ZNBT to start from a well-
defined instrument state.

VNA

DUT >

—

(=)
ORNOMO

ORNONNO
ORNO

O O G
O O 6

O & 6
O O 6

O Gk
©

—]

1 DU

1. Connect the DUT between test ports 1 and 2 of the network analyzer as shown
above.

2. Use the [Preset] key to restore a well-defined instrument state.
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The analyzer is now set to its default state, measuring the transmission S-parame-
ter Sy.

Trel dB Mag 10 dB/ Ref 0 dB

Select Trace — [Trace Config] and use the control elements in the "Traces" softtool tab
if you wish to create additional traces and diagrams.

Selecting the sweep range and other parameters

After a system preset the display shows a diagram with a dB magnitude scale, and the
S-parameter S,, is selected as a measured quantity. This S-parameter is the forward
transmission coefficient of the DUT. It is defined as the ratio of the transmitted wave at
the DUT's output port (port no. 2) to the incident wave at the DUT's input port (port no.
1).

The R&S ZNB/ZNBT automatically adjusts its internal source and receiver to the
selected measured quantities: For an S,; measurement, a stimulus signal (termed a,)
is transmitted at the analyzer port no. 1; the transmitted wave (termed b,) is measured
at port 2. The stimulus signal from the analyzer port no. 2 is not needed except for
some calibration types.

By default the sweep range is set to the frequency range of the analyzer, which can be
unsuitable for your DUT. The following procedure shows you how to configure a
smaller sweep range.

1. Select Stimulus — [Start] and set the "Start Frequency" to the lowest frequency you
want to measure (e.g. 1.77 GHz). For convenient numeric entry, open the "Numeric
Editor" (see Chapter 5.6.2, "Using the numeric editor", on page 63).

Tip: If you use the data entry keys at the front panel for data entry (R&S ZNB only),
type [1][.1[71[7] and terminate the entry with the [G/n] key.

Refer to Chapter 5.6, "Entering data", on page 61 to learn more about entering
numeric values and characters.

2. In the "Stop Frequency" input field, enter the highest frequency you want to mea-
sure (e.g. 2.5 GHz).

3. Select Trace — [Scale] > "Scale Values" and activate the "Auto Scale Trace" func-
tion. The analyzer adjusts the scale of the diagram to fit in the entire S, trace,
leaving an appropriate display margin.
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0,

6.1.3

Transmission S-parameter measurement

Trcl dBMag 0.2 dBf Ref-5.8 dB

Chl Start 1.77 GHz hwr -10 dBm

Tip: Refer to Chapter 5.7, "Scaling diagrams", on page 65 to learn more about the
different methods and tools for diagram scaling.

By default, data acquisition at port 2 starts immediately. For DUTs with large group
delay (> ~10 ns), and if the sweep is optimized for speed, the data acquisition window
can partly overlap with the signal from the previous sweep point. In this case, it is rec-
ommended to configure an additional measurement delay: Start with a measurement
delay of 0, and increase it until the S,, trace becomes stable.

Calibrating the instrument

Calibration (system error correction) is the process of eliminating systematic, reprodu-
cible errors from the measurement results. E.g., in the current test setup, the connect-
ing cables between the analyzer ports and the DUT introduce an attenuation and a
phase shift of the waves. Both effects impair the accuracy of the S-parameter mea-
surement.

The analyzer provides a wide range of sophisticated calibration methods for all types of
measurements. The calibration method to select depends on the expected system
errors, the accuracy requirements of the measurement, on the test setup and on the
types of calibration standards available.

The following example requires a calibration kit with a male Through standard with
known transmission characteristics for the related test port connector type and gender.
With a single Through, it is possible to perform a transmission normalization, compen-
sating for a frequency-dependent attenuation and phase shift in the signal paths.

Due to the R&S ZNB/ZNBT's calibration wizard, calibration is a straightforward, guided
process.

1. Replace the DUT by the Through standard of your calibration kit. Make sure to dis-
connect all calibration units.

2. Select Channel — [Cal] > "Start... (Manual)" to open the "Calibration Setting" wiz-
ard.

3. Select the port combination Port 1 (P1) and Port 2 (P2) and the calibration type
"Trans Norm". Make sure to define port 1 as the source port.
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":Q Calibration Setting

® _ L] | X
Ports and Type
Selectthe ports to be calibrated and the type of the calibration,

Refl Marm ReflMarm Refl OSi Trans Narm  Trans Norm One Path
Open Short Both Two Ports

— — — — — —

T T L A

TRL TOM TaM TR TH& Adapter
Rernoval

Tip: For a R&S ZNBT with more than 4 ports, the graphical port representation is
replaced by a generic port list. The selection logic is unchanged.

4. Select "Next" to proceed to the next page of the "Calibration Setting" wizard.

5. Select the test port connector type and gender (here: N 50 Q, female, correspond-
ing to a male Through standard), and the calibration kit (here: R&S ZV-Z121).
4':1 Calibration Setting
Connectors and Cal Kits

Select co
load anapp

DF’Z

Connector N500 ¥ | N50O =
Port Gender Female ¥ || Female b

N500Q Ideal.. ¥ || N50(Qldeal.. ™

Same Connector Same Gender Import
all Ports O all Ports Cal Kit ...

4— Back P Start

6. Tap"Start".
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7. The calibration dock widget indicates the standard measurements that make up a
"Trans Norm" calibration.
Select "Through (mm)" to initiate the measurement of the connected Through stan-
dard. Measuring the isolation between ports 1 and 2 is optional. Skip it for now.

Trel dB Mag i Trc2 Phase 45°/Ref0" CalOff

Start 9kHz Pwr -10dBm Stop 85GHz |Chl Start SkHz Pwr -10dBm Stop 8

> p1 O P1©O—0 P2

N50 0 (f)
N 50 0 Ideal Kit N 5 al N 50 0 Ideal Kit

o) E)p]»':n :)p]en 'tl'hr-:-lngh
m m mm
S ?::? & S ?:5 & | Isolation

Match Match
(m) {m)

Ch1

Sliding Match Sliding Match
-i- (m) -i_ (m)

Restart Swee
onStd. Meas. Concel (@) Help

Calibration --

The analyzer performs a calibration sweep for the measured quantity S,;. The
magnitude and phase of the result is displayed in two diagrams, together with the
expected typical result for a Through standard. The similarity of real and expected
traces indicates that the Through standard has been properly connected. After the
R&S ZNB/ZNBT has completed the calibration sweep and calculated the correction
data, the "Apply" button is enabled.

8. Select "Apply" to close the wizard.

The system error correction is calculated and applied to the current channel. A
"Cal" label appears in the trace list.

To proceed with the measurement, remove the Through standard and connect the DUT
again.

6.1.4 Evaluating data

The analyzer provides various tools to optimize the display and analyze the measure-
ment data. For instance, you can use markers to determine maxima and minima on the

trace, and change the display format to obtain information about the group delay of the
transmitted wave.

1. Select Trace — [Marker] > "Markers" > "Mkr 1".
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This places marker "M1" to its default position (center of the sweep range). A
marker symbol (triangle) appears on the trace, a marker info field in the upper right
corner of the diagram. The marker info field displays the stimulus value (frequency)
and response value (magnitude of the transmission coefficient converted to a dB
value) at the marker position.

Chl| Start 1GHz Pwr -10dBm Bw T10kHz

Select Trace — [Marker], activate the "Marker Search" softtool tab and activate
"Min" search.

The marker jumps to the absolute minimum of the curve in the entire sweep range.
The marker info field shows the coordinates of the new marker position.

Select Trace — [Format] and choose the "Delay" of the transmission coefficient as
displayed quantity.

The group delay represents the propagation time of the wave through the DUT; it is
displayed in a Cartesian diagram. The marker info field shows the frequency and
group delay at the marker position.

Chil 5tart 1GHz Pwr -10dBm Bw T10kHz Stop 6 GHz

Refer to the information on trace formats in the help system or in the user manual to
learn more about the diagram properties.

Saving and printing data

The analyzer provides standard functions for saving measurement settings and for
saving or printing the results. You can use these functions as if you were working on a
standard PC. Moreover you can export your trace data to an ASCII file and reuse it in a
later session or in an external application.
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6.2

Reflection S-parameter measurement

Data transfer is made easier if external accessories are connected to the analyzer or if
the instrument is integrated into a LAN. Refer to Chapter 3.11, "Connecting external
accessories", on page 22, and Chapter 3.12, "Remote operation in a LAN", on page 25
to obtain information about the necessary steps.

1. Activate the System — [File] > "Trace Data" softtool tab.

2. Inthe "Trace Data" softtool tab, select "Export" — "ASCII..." to open the "Export
Data - ASCII Files" dialog.

3. Inthe "Export Data - ASCII Files" dialog:

a) Select a file location ("Look in:").
b) Enter a file name ("File name:").
c) Select "Save".

The analyzer writes the data of the active trace to an ASCII file and closes the dia-
log.
4. Activate the "Print" softtool tab (System — [File] > "Print").

5. In the "Print" softtool tab, select "Print" to print the diagram area or "To Clipboard"
to copy it to the Windows clipboard.

6. Select System — [File] > "Recall Sets" > "Save..." to open the "Save" dialog for
recall sets.

7. Inthe "Save" dialog:

a) Select a file location ("Look in:").
b) Enter a name for the recall set file ("File name:").
c) Select "Save".

The analyzer saves the active recall set, containing channel, stimulus and trace
settings, to a znx file. This recall set can be restored in a later session.

Reflection S-parameter measurement

In a reflection measurement, the analyzer transmits a stimulus signal to the input port
of the device under test (DUT) and measures the reflected wave. Different trace for-
mats allow you to express and display the results, depending on what you want to
learn from the data. Only one analyzer test port is required for reflection measure-
ments.

In principle, a reflection measurement involves the same steps as a transmission mea-
surement. Note the following differences:

® The basic test setup for reflection measurements involves a single DUT and ana-
lyzer port. For instance, you can connect the input of your DUT to port 1 of the ana-
lyzer as shown below.
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VNA

1 DUT

You can also use the basic transmission test setup, e.g. if you want to measure
reflection and transmission parameters in parallel.

® The analyzer provides special calibration types for reflection measurements. Use
the calibration wizard and select an appropriate type.
A full n-port calibration (TOSM, UOSM, TNA ...) corrects the system errors for all
transmission and reflection S-parameters.

® Some of the trace formats are particularly suited for reflection measurements. For
instance, you can display the measured reflection coefficient Sy, in a Smith chart to
obtain the complex input impedance at port 1.

Chl Start 1.77 GHz Pwr -10 dBm

Proceed as described in Chapter 3.7, "Switching the instrument on and off",
on page 18 to shut down your analyzer.
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7 Firmware installation

Upgrade versions of the analyzer firmware are supplied as single executable setup
files (* . exe).

@ 64-bit only
For analyzer firmware versions = 3.0, 32-bit Windows is no longer supported . Only 64-
bit firmware is available.

To upgrade your instrument to 64-bit Windows 10, contact Rohde & Schwarz service.

® Admin account
You need administrator rights to install a new firmware. See Chapter 3.9, "Windows
operating system", on page 20 for details.

To perform a firmware update:

1. Copy the setup file to any storage medium accessible from the analyzer. This can
be either the internal mass storage drive, an external storage medium (USB mem-
ory stick, external CD-ROM drive) or a network connection (LAN).

The default name of the internal drive is C:. External storage devices are automati-
cally mapped to the next free drive, i.e. D:, E: etc.

2. Run the setup file from the Windows® Explorer. Follow the instructions of the setup
wizard.
Setup files can be reinstalled.

O Factory calibration
S A firmware update does not affect the factory calibration.

@ Downgrade to a firmware version < 3.00

To downgrade the firmware from a version = 3.00 to a version < 3.00, it is required to
uninstall the firmware using Windows 10 "Apps & features" before proceeding with the
installation.
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8 Contacting customer support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz product, contact our customer sup-
port center. A team of highly qualified engineers provides support and works with you
to find a solution to your query on any aspect of the operation, programming or applica-
tions of Rohde & Schwarz products.

Contact information

Contact our customer support center at www.rohde-schwarz.com/support, or follow this

QR code:
[ |

Figure 8-1: QR code to the Rohde & Schwarz support page
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